# Table Of Contents

## Getting Started
- Welcome to Blackboard IM ......................................................... 1
- What’s New In 4.1? ................................................................. 1
- What’s New in Blackboard IM? .................................................. 2
- System Requirements .................................................................. 2
- Creating a Blackboard IM Account .............................................. 3
  - Locating a Blackboard IM Link in Your Course Management System 5
  - Linking Accounts ..................................................................... 6
- Downloading and Installing Blackboard IM ................................... 6
- Logging In .................................................................................. 8

## Interface Overview
- About the Blackboard IM Interface .......................................... 11
- The Contacts Tab ....................................................................... 13
- The Classmates Tab .................................................................... 13
- The School Tab .......................................................................... 14
- The Status Bar ........................................................................... 15

## Managing Your Accounts and Contacts
- About Accounts and Contacts .................................................... 17
- Adding a New Contact to Your Contacts Tab ............................... 17
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding a New Group to Your Contacts Tab</td>
<td>19</td>
</tr>
<tr>
<td>Adding a Contact to a Group</td>
<td>19</td>
</tr>
<tr>
<td>Removing a User from Your Contacts Tab or a Group</td>
<td>20</td>
</tr>
<tr>
<td>Changing Your Status</td>
<td>21</td>
</tr>
<tr>
<td>Creating a New Custom Status</td>
<td>22</td>
</tr>
<tr>
<td>Modifying Your Profile</td>
<td>24</td>
</tr>
<tr>
<td>Profile Picture</td>
<td>24</td>
</tr>
<tr>
<td>Email</td>
<td>24</td>
</tr>
<tr>
<td>About Me</td>
<td>25</td>
</tr>
<tr>
<td>My Webpages</td>
<td>25</td>
</tr>
<tr>
<td>Changing Your Display Settings</td>
<td>25</td>
</tr>
<tr>
<td>Show Offline Contacts</td>
<td>26</td>
</tr>
<tr>
<td>Show Blocked Contacts</td>
<td>26</td>
</tr>
<tr>
<td>Show Unregistered Classmates</td>
<td>26</td>
</tr>
<tr>
<td>Sort Contacts by First Name</td>
<td>26</td>
</tr>
<tr>
<td>Sort Contacts by Last Name</td>
<td>26</td>
</tr>
<tr>
<td>Sort Contacts by Availability</td>
<td>26</td>
</tr>
<tr>
<td>Show Group Counts</td>
<td>26</td>
</tr>
<tr>
<td>Collapse All Groups</td>
<td>26</td>
</tr>
<tr>
<td>Expand All Groups</td>
<td>26</td>
</tr>
<tr>
<td>Show Status Messages</td>
<td>27</td>
</tr>
<tr>
<td>Blocking and Unblocking Users</td>
<td>27</td>
</tr>
<tr>
<td>Viewing a User's Profile</td>
<td>28</td>
</tr>
<tr>
<td>Accessing the Blackboard IM Settings Page</td>
<td>29</td>
</tr>
<tr>
<td>Modifying Your Account Settings</td>
<td>30</td>
</tr>
<tr>
<td>To Change Your Security Question</td>
<td>31</td>
</tr>
<tr>
<td>To Change the Language Setting for Your Blackboard IM Account</td>
<td>32</td>
</tr>
<tr>
<td>Modifying Your Course Settings</td>
<td>32</td>
</tr>
<tr>
<td>General</td>
<td>33</td>
</tr>
<tr>
<td>Course Participant</td>
<td>33</td>
</tr>
<tr>
<td>Course Instructor (Displays for Instructors Only)</td>
<td>33</td>
</tr>
<tr>
<td>Invitations</td>
<td>34</td>
</tr>
<tr>
<td>Inviting Users to Blackboard IM</td>
<td>35</td>
</tr>
<tr>
<td>Instructors</td>
<td>36</td>
</tr>
</tbody>
</table>
# Chatting

- About Chat ................................................................. 39
- Starting a New Chat ..................................................... 39
- The Chat Window .......................................................... 40
  - The Call Button ......................................................... 41
  - The Collaborate Button .............................................. 41
  - The Profile Drawer Button ........................................ 42
  - The Message Area ..................................................... 42
  - The Text Input Area .................................................. 42
  - Chat Tabs ................................................................. 42
- Using Emoticons .......................................................... 43
- Using HTML ............................................................... 43
- Using URLs ............................................................... 45
- Group Chat ............................................................... 47
  - About Group Chat .................................................... 47
  - Starting a New Group Chat ......................................... 47
  - Inviting New Users to a Current Group Chat ................. 50
- Ending a Chat ............................................................ 50

# Calling

- About Calling ............................................................ 51
  - Audio ................................................................. 51
  - Video ................................................................. 51
  - Requirements ........................................................ 52
- Starting a New Call ....................................................... 52
- The Audio & Video Window .......................................... 53
  - The User Display Area ............................................. 54
  - Microphone and Speaker Volume Bars ......................... 54
  - The Talk Button ..................................................... 54
  - The Video Button ................................................... 55
  - The Options Menu .................................................. 55
  - Video Capture ........................................................ 56
- Ending a Call ............................................................. 56

# Collaborating

- About the Collaboration Window .................................. 59
# Table of Contents

- Opening the Collaboration Window ................................................................. 59
- The Collaboration Window ............................................................................... 61
  - The Whiteboard Button .............................................................................. 61
  - The Screen Sharing Button ....................................................................... 62
  - The Web Tour Button .............................................................................. 62
  - Content Area ............................................................................................. 62
- Using the Whiteboard ...................................................................................... 62
  - About the Whiteboard ............................................................................... 62
  - Starting a Whiteboard Session ................................................................. 63
  - The Whiteboard Window ........................................................................... 63
- Whiteboard Tools ............................................................................................ 66
  - Whiteboard Tool Options ......................................................................... 68
  - Modifying Objects on a Whiteboard ......................................................... 69
  - The Whiteboard Gallery Ribbon ............................................................... 71
- Loading Content into a Whiteboard ............................................................... 73
  - Saving Whiteboards .................................................................................. 74
- Whiteboard Action Tracking .......................................................................... 76
  - The Whiteboard Action Bar ..................................................................... 76
- Using Screen Sharing ...................................................................................... 78
  - About Screen Sharing .............................................................................. 78
  - Starting Screen Sharing ........................................................................... 78
  - The Screen Sharing Window .................................................................... 78
- Using the Web Tour .......................................................................................... 80
  - About the Web Tour .................................................................................. 80
  - Starting a Web Tour .................................................................................. 80
  - Using the Web Tour .................................................................................. 81
- Closing the Collaboration Window ................................................................. 82

## Using Web Conferencing ................................................................................ 83
  - About Web Conferencing ......................................................................... 83
  - Starting a Web Conference ....................................................................... 84
  - Viewing Recordings ................................................................................... 85

## Using Office Hours ......................................................................................... 87
  - About Office Hours ................................................................................... 87
  - The Office Hours Views ............................................................................ 87
The Office Hours Owner Window ................................................................. 88
The Waiting Room Window .................................................................. 89
The Main Room Participant Window ..................................................... 90
For Owners ............................................................................................... 90
Starting a New Default Office Hours Session ........................................ 90
Starting a New Custom Office Hours Session ........................................ 91
The Office Hours Owner Window ............................................................ 93
Promoting a Participant to the Main Room ............................................ 96
Demoting a Participant to the Waiting Room ......................................... 97
Removing a Participant from an Office Hours Session ......................... 99
Viewing Waiting Room Chat .................................................................. 100
Sending a Message to the Waiting Room ............................................... 101
Ending an Office Hours Session ........................................................... 103
For Participants ....................................................................................... 104
Joining an Office Hours Session ........................................................... 104
The Waiting Room Window .................................................................. 105
The Main Room Participant Window ..................................................... 107
Using Help Desks ................................................................................... 111
About Help Desks .................................................................................. 111
The School Tab ...................................................................................... 112
  The Help Desk List ................................................................................ 112
  My Staff Positions ................................................................................ 113
Joining a Help Desk .............................................................................. 113
Assuming the Staff Role for a Help Desk .............................................. 114
Leaving the Staff Role for a Help Desk .................................................. 115
Creating and Managing Help Desks ...................................................... 116
Message Logs .......................................................................................... 117
Saving a Single Chat ............................................................................. 117
Enabling Automatic Message Log Saving .......................................... 118
Viewing Message Logs .......................................................................... 118
Preferences ............................................................................................. 121
Accessing the Preferences Window ....................................................... 121
General Preferences .............................................................................. 123
  Sign In .................................................................................................. 123
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages</td>
<td>124</td>
</tr>
<tr>
<td>Updates</td>
<td>124</td>
</tr>
<tr>
<td>Chat Logs</td>
<td>124</td>
</tr>
<tr>
<td>Language</td>
<td>124</td>
</tr>
<tr>
<td>Appearance Preferences</td>
<td>125</td>
</tr>
<tr>
<td>Messages</td>
<td>125</td>
</tr>
<tr>
<td>Header</td>
<td>126</td>
</tr>
<tr>
<td>Message Body</td>
<td>126</td>
</tr>
<tr>
<td>Contact List</td>
<td>126</td>
</tr>
<tr>
<td>Reset Appearance Defaults</td>
<td>126</td>
</tr>
<tr>
<td>Status Preferences</td>
<td>126</td>
</tr>
<tr>
<td>Alerts Preferences</td>
<td>127</td>
</tr>
<tr>
<td>Calls Preferences</td>
<td>129</td>
</tr>
<tr>
<td>Privacy Preferences</td>
<td>131</td>
</tr>
<tr>
<td>Profile Preferences</td>
<td>132</td>
</tr>
<tr>
<td>Profile Picture</td>
<td>133</td>
</tr>
<tr>
<td>Email</td>
<td>133</td>
</tr>
<tr>
<td>About Me</td>
<td>133</td>
</tr>
<tr>
<td>My Webpages</td>
<td>133</td>
</tr>
<tr>
<td><strong>Other Features</strong></td>
<td>135</td>
</tr>
<tr>
<td>Broadcast Notifications</td>
<td>135</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>136</td>
</tr>
<tr>
<td>Main Window</td>
<td>136</td>
</tr>
<tr>
<td>Chat Window</td>
<td>137</td>
</tr>
<tr>
<td>Audio &amp; Video Window</td>
<td>138</td>
</tr>
<tr>
<td>Office Hours window and Help Desk window</td>
<td>139</td>
</tr>
<tr>
<td>Whiteboard</td>
<td>140</td>
</tr>
<tr>
<td>Web Tour</td>
<td>140</td>
</tr>
<tr>
<td>General</td>
<td>141</td>
</tr>
<tr>
<td>Software Updates</td>
<td>141</td>
</tr>
<tr>
<td>Language Settings</td>
<td>142</td>
</tr>
<tr>
<td>Additional Resources</td>
<td>143</td>
</tr>
<tr>
<td>Technical Support</td>
<td>143</td>
</tr>
<tr>
<td>Additional Documentation</td>
<td>143</td>
</tr>
</tbody>
</table>
Community ...................................................................................................................... 144
Blackboard Collaborate Product Feedback ................................................................. 144
Index ............................................................................................................................. 145
Copyright ..................................................................................................................... 149
Trademarks .................................................................................................................. 149
Welcome to Blackboard IM

Blackboard IM is an academic-centric instant collaboration solution designed to promote learning through group work and academic and administrative help. One of the main differences between Blackboard IM and other collaboration solutions is that Blackboard IM synchronizes with your institution's enrollment records. This means that students and teachers are automatically connected with other Blackboard IM users enrolled in the same courses. Blackboard IM also includes advanced features such as video chat, screen sharing, and a robust whiteboard, which allow everyone at your institution to collaborate and communicate quickly and easily.

If you don't already have Blackboard IM, follow the instructions in Creating a Blackboard IM Account on page 3 to get it.

Top Blackboard IM Features

These are some of the most helpful features of Blackboard IM:

- **Chat** to communicate quickly and efficiently with your classmates
- **Calls** for more natural communication with one-on-one or group conversations
**Collaboration** to share ideas with others
- **Screen Sharing** for real-time display of any document or application on your computer
- **Whiteboard** to harness the power of visual instruction
- **Web Tour** to share webpages

**Web Conferencing** to use Blackboard Collaborate web conferencing for a full online classroom

**Office Hours** to create a focused setting where classmates and contacts can line up for individual attention

**Help Desks** for virtual assistance from the administrative services at your institution

**Broadcast Notifications** for institution-wide alerts

---

**What's New In 4.1?**

- Blackboard IM now features *echo cancellation*, which eliminates echoes when you are using speakers and a microphone (as opposed to a headset). To enable it, select **Echo Cancellation** in the **Calls Preferences**.
- The Blackboard IM client is now available in French (as well as English and Spanish). To select it, use the **Language** setting in the **General Preferences**.
- You can now choose to have an audible alert when a user enters a help desk. To enable it, set **Play sound** for the **Helpdesk room entered** choice in the **Alerts Preferences**.

---

**What's New in Blackboard IM?**

Blackboard Collaborate is pleased to announce the release of Blackboard Collaborate enterprise instant messaging, or Blackboard IM, as the instant messaging capability of the all new Blackboard Collaborate platform. This release of Blackboard IM (formerly Wimba Pronto) provides:

- **Unified Collaboration Window**
  - Whiteboard, desktop sharing, and guided web tours are centralized in a “unified collaboration” window for displaying shared content.

- **Redesigned Audio and Video Calls**
  - A single call button from the chat windows allows easy audio -> video -> audio transitioning.
• **Launching a Web Conference**
  Instructors can see their students and peers in Blackboard IM and immediately invite them to a web conferencing room. (This is available to customers who have also licensed Blackboard Collaborate web conferencing and have deployed Blackboard Collaborate 11.)

• **Chat, call, conference “Quick Launch” buttons**
  Quickly start up a group chat, call or web conference, with the ability to invite a single user, multiple users, contact groups, or entire courses.

---

**See Also:**
Chatting  
Calling  
Collaborating  
Using Web Conferencing

---

**System Requirements**

The minimum system requirements for Blackboard IM are as follows:

- Windows XP+ or Mac OS 10.5+
- 128 MB RAM (256 MB recommended)
- An Internet connection at 56 kbps or higher
- Sound card (for Audio Calling)
- Speakers and microphone for audio calling  
  (USB headset with integrated microphone recommended)
- USB or integrated webcam (for Video Calling)

---

**Creating a Blackboard IM Account**

Use one of these three methods to create a Blackboard IM account:

- **Through a Course Management System**: Navigate to any Blackboard IM link in your institution's Course Management System (CMS). For complete instructions, refer to Locating a Blackboard IM Link in Your Course Management System.
- **By Invitation**: Follow the instructions and click the link in an email invitation from Blackboard Collaborate, your institution, or another Blackboard IM user (such as an instructor or classmate).
• **With a Registration Code:** Go to the Blackboard IM Registration page here and enter a unique registration code from your institution along with your last name (surname) as it appears in your institution's systems.

Each of these methods leads to the Blackboard IM registration page. Follow the steps below to fill out the form.

**Create a Blackboard IM account**

Your Blackboard IM ID will be used for log in and will display to other users. All fields are required.

- **Create your Blackboard IM ID:**
- **Email:**
- **Confirm Email:**
- **Choose a Password:**
- **Confirm Password:**
- **Security Question:**

**Important!** The answer to your security question will be required if you forget your password.

- **Answer:**

[ ] By registering for this service, I've read and agree to the Blackboard IM Terms and Conditions which includes my consent to the use of cookies to store personal information in connection with providing the service. More information on the use of cookies is available at the Blackboard Privacy Center.

**To Create a Blackboard IM Account**

1. **Create your Blackboard IM ID:** In Blackboard IM, you are identified by your full name, as it appears in your institution's systems. Your Blackboard IM ID is used for logging in, managing your account, and allowing users who are not in your classes to contact you. This ID is unique and does not need to match your institution's systems. If you are associated with two or more institutions that use Blackboard IM, you can use the same Blackboard IM ID for both (refer to Linking Accounts for instructions).

2. **Email:** Each Blackboard IM ID must be associated with a unique email address.

3. **Password:** Enter a password that is memorable, but difficult to guess.

4. **Security Question:** Choose a security question from the list and provide the answer. In the event that you cannot remember your password, this question will be used for password recovery.

5. Agree to the Terms and Conditions of service and the cookie privacy policy.

6. **Click Submit.**

Once you have created your Blackboard IM ID, you can install Blackboard IM on your computer. For complete details, refer to Downloading and Installing Blackboard IM.
Note:
Unlike in other instant collaboration solutions, in Blackboard IM, you are identified by your full name, as it appears in your institution’s systems. There is also a Blackboard IM ID associated with your account, which is used for logging in, managing your account, and allowing users who are not in your classes to contact you.

See Also:
- Downloading and Installing Blackboard IM
- Locating a Blackboard IM Link in Your Course Management System
- System Requirements
- Inviting Users to Blackboard IM

Locating a Blackboard IM Link in Your Course Management System
Blackboard IM synchronizes with course enrollments at your institution, so you can access the Blackboard IM registration page (and later, the Blackboard IM Settings page) via a link in your Course Management System (CMS).

To Locate a Blackboard IM Link in Your CMS

1. Log in to your Course Management System.
2. Navigate to any Blackboard IM link. This step varies slightly between CMS systems:
   - If you are using Blackboard Enterprise or Learn, the Blackboard IM link may be located in the Communication Area, the Tools Area, or on the My Institution page.
   - If you are using Blackboard Vista / Campus Blackboard Vista/Campus WebCT Edition, the Blackboard IM link may be located in the External Courses area of the My Blackboard (or My WebCT) page, or within a Section.
   - If you are using Moodle, the Blackboard IM link can either be an activity within a course, or an image within a Block.
3. The Blackboard IM registration form appears. If you have already created a Blackboard IM account, the Blackboard IM Settings page appears instead.

For information on registering for Blackboard IM, refer to Creating a Blackboard IM Account.
Linking Accounts

If you change institutions and want to continue using your existing Blackboard IM account, you can link it to your new institution. As long as you are still active on your previous institution's server, you can also access a list of your classmates for both institutions simultaneously.

To Link an Existing Blackboard IM Account to a New Institution

1. Use any of the three methods detailed in Creating a Blackboard IM Account as it pertains to your new institution. The Blackboard IM Registration page appears.

   ![Step 3: Install and Start Chatting](image)

   [Already have a Blackboard IM account? Link it!](link)

2. Click the **Already have a Blackboard IM account? Link it!** link. The Link Your Blackboard IM Account page opens.

3. Log in using your existing Blackboard IM account information. Your new account is linked to your Blackboard IM account and the Blackboard IM Settings page opens.

   **Note:**
   If your institution is Walled In, you will not be able to link your accounts unless you are an administrator or instructor. Students at Walled In institutions can only communicate within a single institution. As an alternative, you can create a second Blackboard IM ID with a different email address at your second institution.

Downloading and Installing Blackboard IM

You can download and install the Blackboard IM client after creating your Blackboard IM account. You may perform this step either immediately after creating your account, or at a later time.

**Tip:**
You can install Blackboard IM on as many computers as you wish, making it easy to keep in touch with friends and classmates, even if you are not at your primary computer.
To Download and Install Blackboard IM for Windows

1. Log in to the Blackboard IM Settings page using your Blackboard IM ID and password.
   - If you just created your account, you may already be logged in to the Blackboard IM Settings page.
   - If you did not just create your account, or you need to download and install Blackboard IM again, go to http://www.blackboardim.com/ and sign in using your Blackboard IM ID and password.

2. In the Download section, click the Windows 7, Vista, XP link. The Blackboard IM installer downloads to your hard drive.

3. Double-click the BlackboardIMSetup file that was downloaded. The installer launches.
4. Click OK.
5. Click Next.
6. Review the license agreement and click I Agree.
7. Select whether you wish to install Desktop and QuickLaunch Shortcuts.
8. Click Next.
9. Select where you wish to install Blackboard IM.
10. Click Install. Blackboard IM installs and a confirmation screen opens.
11. Select whether you wish to run the program right away.
12. Click Finish.

To Download and Install Blackboard IM for Macintosh

1. Log in to the Blackboard IM Settings page using your Blackboard IM ID and password.
   - If you just created your account, you may already be logged in to the Blackboard IM Settings page.
   - If you did not just create your account, or you need to download and install Blackboard IM again, go to http://blackboardim.com/ and sign in using your Blackboard IM ID and password.
2. In the Download section, click the **Mac OS X** link. The Blackboard IM installer downloads to your hard drive and the End User License Agreement opens.

3. Review the license agreement and click **Agree**. The disk image opens.

4. Drag the **Blackboard IM** icon to the Applications folder icon.

5. Launch Blackboard IM from your Applications folder.

**See Also:**
- Language Settings
- Creating a Blackboard IM Account
- Accessing the Blackboard IM Settings Page

**Logging In**

You log in to the Blackboard IM client using the Blackboard IM ID and password that you chose when creating your account. Whenever you launch Blackboard IM, the login window appears.
To Log in to Blackboard IM

1. Enter your Blackboard IM ID.
2. Enter your Blackboard IM password.
3. Click the **sign in** button.

---

**Tips:**

a) You can set Blackboard IM to remember your Blackboard IM ID and password by checking the **remember me box**. If you do this, anyone with access to your computer can access your Blackboard IM account.

b) You can also set Blackboard IM to automatically sign you in when you launch the program by checking the **sign in automatically** box. This setting can be changed in the Preferences window.

---

**See Also:**
Creating a Blackboard IM Account
Interface Overview

About the Blackboard IM Interface

Blackboard IM is based around the Blackboard IM window, from which you manage communication with other users and access the program's more advanced features. The main elements at the top of the Blackboard IM window are the Menu Bar, the Status Bar, the Contacts tab, the Classmates tab, and the School tab.
The bottom of the window holds the Chat, Call, and Conference buttons.

**Note:**
On Mac OS X, the Menu Bar is located at the top of the screen, rather than within the Blackboard IM window.

**See Also:**
- Adding a New Contact to Your Contacts Tab
- Changing Your Status
The Contacts Tab

The Contacts tab is where you keep track of your friends, study groups, and anyone else that you contact often. This tab is initially empty, but you can add any Blackboard IM user, as long as you know his or her Blackboard IM ID; the user does not need to be in one of your classes, or even at your institution. The Find field allows you to search for a specific user in the list. You can also add groups to keep your contacts organized.

The Classmates Tab

The Classmates Tab
The Classmates tab lists all of the Blackboard IM users who are in your classes. If the instructor of a course has a Blackboard IM account, the label (Instructor) appears next to his or her name. You do not need to add users to your Classmates tab; it is automatically populated based on course enrollments within your institution's Course Management System. You also cannot manually add or delete classmates. The Find field allows you to search for users in the list.

**Tip:**
Classmates appear only while you are enrolled in a class. However, users remain in your Contacts tab indefinitely, so make sure you add classmates with whom you want to keep in touch as contacts before the semester ends.

---

**The School Tab**

The School tab lists the Help Desks that your institution has set up. These may include campus offices, library services, academic counseling, or any other resource that your institution wants to make easily available. A number appears in the tab label when Help Desks are available. Open Help Desks display the Office Hours icon ☑️ next to their name, while closed Help Desks display the offline icon ☑️. Help Desks can only be added, deleted, or modified by your institution’s Blackboard IM Administrator. The Find field allows you to search the list for a specific Help Desk.

If you are an instructor, this tab also enables you to assume the staff role for a help desk. See The School Tab in the Help Desk section.
Note:
The School tab appears only if your institution has set up at least one Help Desk.

The Status Bar

The Status Bar shows your current availability. Since other Blackboard IM users see this status, you can use it to tell other people what you are doing and if it is a good time to contact you. Status messages are fully customizable and can be saved for future use.

See Also:
Changing Your Status
Creating a New Custom Status
Managing Your Accounts and Contacts

About Accounts and Contacts

One of the unique features of Blackboard IM is that it automatically populates your Classmates tab, allowing you to communicate with other Blackboard IM users in your classes without having to know their Blackboard IM IDs. You can quickly see how many people from each of your classes use Blackboard IM, and who is currently online. You can still keep a personalized list of users by using the Contacts tab, which allows you to add Blackboard IM users, regardless of whether or not they are in your classes.

Adding a New Contact to Your Contacts Tab

The Contacts tab is where you keep track of your friends, classmates, instructors, and anyone else that you want to be able to easily contact. You can add any Blackboard IM user to your contacts, even if they are not in one of your classes or enrolled at your institution.

To add a classmate to your Contacts tab, click the plus icon 😊 next to the user's name in the Classmates tab. The smiley icon 😊 indicates that the user has been added to your Contacts tab.
To Add a User to Your Contacts Tab by Blackboard IM ID

1. Click Add Contact on the People menu. The Add Contact window opens.
2. Type the Blackboard IM ID of the user you wish to add.
3. Select the group within your Contacts tab to which you wish to add the person.
4. Click Add. The user is added to your Contacts tab.

Note:
You can use the Blackboard IM ID method to add any Blackboard IM user to your Contacts tab, even if they are in your Classmates tab. However, clicking the plus icon is the faster way to add classmates.

Tip:
If a user who is not in your Contacts or Classmates tab contacts you, a notification appears above the message giving you the option to add the user to your Contacts tab or to block the user.

See Also:
Adding a New Contact to Your Contacts Tab
Adding a Contact to a Group
Removing a User from Your Contacts Tab or a Group
Adding a New Group to Your Contacts Tab

You can organize users in your Contacts tab by groups. For example, you could create a group for your study partners, or for your friends from high school. When you start Blackboard IM for the first time, the Contacts tab is empty. When you add a new contact, unless you specify otherwise in the Add Contact window, the user is automatically added to a default group called Recently Added. You can create as many groups as you wish to keep your contacts organized.

To Create a New Group

2. Type the name of the group you wish to create.
3. Click Add. The group is created and added to your Contacts tab.

See Also:
Adding a New Contact to Your Contacts Tab
Adding a Contact to a Group

Adding a Contact to a Group

Once you have created groups in your Contacts tab, the next step is to add contacts to these groups. There are a couple of different ways to add a contact to a group, depending on whether or not you have already added the user to your Contacts tab.

To add a user that is already in your Contacts tab to a group, simply drag and drop his or her name to the name of the group.
To Add a User Not Already in Your Contacts Tab to a Group

1. Click Add Contact on the People menu. The Add Contact window opens.

   ![Add Contact Window]

2. Type the Blackboard IM ID of the person you wish to add.
3. Select the group to which you wish to add the person.
4. Click Add. The user is added to the selected group within your Contacts tab.

See Also:
Adding a New Contact to Your Contacts Tab
Adding a New Group to Your Contacts Tab
Removing a User from Your Contacts Tab or a Group

Removing a User from Your Contacts Tab or a Group

The process for removing a user from your Contacts tab is the same as removing a user from a group; if you remove a user from a group, he or she is also removed from the Contacts tab (unless the person is in more than one group). There are two different ways to accomplish this.

To Remove a Contact Using the Contacts Tab

1. Click the Contacts tab, if it is not already selected.
2. Right-click (Ctrl-click on Macintosh) the name of the contact that you wish to remove.
3. Select Remove User Name. The Remove User Name window opens.
4. Click OK. The user is removed from both the Contacts tab and the group.

To Remove a Contact Using the Actions Menu

1. Click the Contacts tab, if it is not already selected.
2. Click the name of the contact that you wish to remove.
3. On the People menu, click **Remove User Name**. The Remove User Name window opens.

4. Click OK. The user is removed from both the Contacts tab and the group.

---

**Note:**
If you remove a contact that is in one of your courses, he or she will still be listed in your Classmates tab. Since the Classmates tab is automatically populated from your institution's enrollments, you cannot manually add or remove classmates.

---

**See Also:**
- Adding a New Contact to Your Contacts Tab
- Adding a Contact to a Group

---

**Changing Your Status**

The Status Bar displays your current availability. Other Blackboard IM users see this status, so you can use it to tell other people what you are doing, and if it is a good time to contact you. You can change your status to one of the default options, or create a new custom status.

The default status options are:

- **Available**
  The Available status lets other users know that you are free and that it's a good time to contact you.

- **Away**
  The Away status lets other users know that you are busy and that it may not be a good time to contact you. You may wish to create a custom away status to let other people know what you're doing or when you'll be back.

- **Office Hours**
  The Office Hours status is unique because selecting it accesses a Blackboard IM feature, instead of just displaying a status message. When you set your status to Office Hours, a new Office Hours session is started with you as the host.

- **Invisible**
  The Invisible status is a way of hiding yourself from other users while still remaining online. When you set your status to Invisible, you appear to others as if you were offline, but you can still communicate with other users normally. If your status is set to Invisible and another user tries to send you a message, you will receive the message.

- **Offline**
  The Offline status is the same as logging out of your Blackboard IM Account; when you are offline, you cannot contact other users and other users cannot contact you. If you are offline, and another user tries to send you a message, you will not receive the message.
To Change Your Status

1. Click the Status Bar.

2. Select the desired status. Your new status is set.

See Also:
Creating a New Custom Status
Using Office Hours Status Preferences

Creating a New Custom Status

If you do not want to use the default status messages, or you prefer to display a more specific message, you can create a custom status. While the most common use of custom statuses is creating custom away messages, you can also create a custom available status. Custom statuses can be saved for future use.
To Create a New Custom Status

1. Click the Status Bar.

2. Select Custom... under Available, Away, or Office Hours. The Edit Custom Status window opens.

3. Type a name for the status in the Title field. This title is for your own reference only and is not seen by other users.

4. Type the status in the Message field. This is the text that is displayed to other users.

5. If you wish to be able to reuse this status in the future, check the Save for future use box.

6. If you want other users to automatically receive a reply message with your status when enabled, check the Auto-reply box.

7. Click OK. The custom status is created and is set as your current status.

Tips:
- If you want the Title and the Message of the Status to be the same, you can simply type the text in the Message field; the Title field is filled in automatically.
- You can edit the list of saved custom statuses through the Status Preferences.

See Also:
Changing Your Status
Modifying Your Profile

You can create a personalized profile with a picture to share information about yourself with other Blackboard IM users. Adding a picture, or other information, is optional. You can add or modify profile information from the Profile section of the Preferences window.

To access the Profile editor, click your profile picture box to the left of the Status Bar in the Blackboard IM window.

Profile Picture

You can add a profile picture that is visible to other Blackboard IM users to add a personal touch to your profile. Your picture is visible any time you contact another Blackboard IM user, anytime another user contacts you, when a user views your profile, or when a user hovers his or her cursor over your name in the Contacts or Classmates tab. To add a profile picture, either drag an image file from your hard drive to the Drag Image Here box, or click the Choose Picture... button and browse your hard drive for the desired picture. The profile picture box is optimized for square images, but accepts images of any proportions.

Email

You can add an email address to make it easier for other users to contact you when you're not on signed in to Blackboard IM. This address does not need to be your school email address or the address associated with your Blackboard IM account.
About Me
The About Me box allows you to type a brief description to introduce yourself to other users. You may wish to include your interests, your major, where you're from, or the type of people with whom you would like to communicate using Blackboard IM.

My Webpages
The My Webpages box allows you to include links in your profile to the websites of your choice. You may wish to add personal, course, or department webpages.

See Also:
Profile Preferences

Changing Your Display Settings
You can control the way in which users are displayed in the Blackboard IM window by using the View menu. These display settings apply to both the Contacts and the Classmates tabs.
Show Offline Contacts
Toggles the display of users that are not currently logged in to Blackboard IM

Show Blocked Contacts
Toggles the display of users that you have blocked

Show Unregistered Classmates
Toggles the display of classmates that are not currently registered for Blackboard IM; this option only appears if Invitations are enabled at your institution

Sort Contacts by First Name
Displays users organized alphabetically by first name

Sort Contacts by Last Name
Displays users organized alphabetically by last name

Sort Contacts by Availability
Displays users that are available first, followed by users that are away, users that are idle, and users that are offline

Show Group Counts
Toggles the display of user counts for each group or course

Collapse All Groups
Hides the user list for all groups, showing only the group name. You can collapse or expand individual groups by clicking the arrow next to the group name.

Expand All Groups
Reveals the user list for all groups. You can collapse or expand individual groups by clicking the arrow next to the group name.
Show Status Messages

Toggles the display of users' custom status messages under their names in the Blackboard IM window. If this option is disabled, you can view a user's status by hovering your mouse over his or her name.

See Also:
Blocking and Unblocking Users

Blocking and Unblocking Users

By default, all Blackboard IM users can freely communicate with each other, regardless of whether or not they are in same classes, or even at the same institution. However, if there are users that you do not want to be able to contact you, you can block them. Blocked users cannot contact you, and you cannot contact them. If the user is in either your Contacts or Classmates tab, you can still see his or her status, but you always appear as offline to the blocked user. Users never know that they have been blocked, and you can unblock users at any time.

You can block or unblock a user from either the Blackboard IM window or the Preferences window. Also, if someone not in your Contacts or Classmates tab contacts you, you are given the option of blocking the user.

To Block a User from the Blackboard IM Window

1. Right-click (Ctrl-click on Macintosh) the name of the user that you wish to block in either the Classmates or Contacts tab.
2. Select Block User Name from the pop-up menu. The Block Contact window opens.
3. Click Yes. The name appears with a strikethrough to indicate that the user has been blocked.

Note:
If the user is already blocked, the Block User Name option changes to Unblock User Name; you can use this option to unblock the selected user.
Tip:
If you do not want blocked users to appear in your Contacts and Classmates tabs, disable **Show Blocked Contacts** in the View menu.

To Manage Blocked Users from The Preferences Menu

1. Click the **Blackboard IM** menu.
2. Select **Preferences...** The Preferences window opens.
3. Select **Privacy**.
4. Add or remove users from your Block List as desired:
   a. To add a user to your Block List, click the plus button +, type the user's Blackboard IM ID, and click **Add**.
   b. To remove a user from you Block List, select the user from the list and click the minus button -.
5. When you have finished modifying the Block List, click **OK**.

Tip:
Since the Block List allows you to block users by their Blackboard IM IDs, you can use this method to block any Blackboard IM user— even if he or she is not in any of your classes.

See Also:
Privacy Preferences
Changing Your Display Settings

Viewing a User's Profile

Any Blackboard IM user can create a Profile to share with friends, classmates, and instructors. You can use Profiles to find out more information about a user, or to find a user's contact information (if he or she has shared it).

You can see a partial profile by hovering your cursor over a user's name in your Contacts or Classmates tab. This view shows you the user's picture, current status, and About Me description; it does not show email addresses or webpages.

To View a User's Profile

1. Click the name of the desired user in either your Contacts or Classmates tab.
2. On the **People** menu, click **Show Profile**.
   A new Chat window opens with the user's profile displayed.
See Also:
Modifying Your Profile

Accessing the Blackboard IM Settings Page

The Blackboard IM Settings page is a web portal that allows you to view and manage your account settings and login information, as well as determine which of your courses appear in Blackboard IM. You can access the Blackboard IM Settings page either from a link within Blackboard IM, or directly using your web browser.
To Access the Blackboard IM Settings Page from Blackboard IM

1. Click the **Blackboard IM** menu.
2. Select **Manage Account**. The Blackboard IM Sign In page opens in your web browser.

3. Type your Blackboard IM ID.
4. Type your Blackboard IM password.
5. Click the **Sign In** button.

**See Also:**
- Modifying Your Account Settings
- Modifying Your Course Settings

**Modifying Your Account Settings**

From the Blackboard IM Settings page, you can view and modify your account settings including your password, the email address associated with your account, and your security question.
To Change Your Password

1. On the Blackboard IM Settings page, click the change password... link. The Change Password window opens.
2. Type your current password in the Current password field.
3. Type your desired password in the New password field.
4. Re-type your desired password in the Confirm new password field.
5. Click the Save button. The Password changed confirmation page opens, indicating that your new password has been successfully updated.

To Change the Email Address Associated with Your Blackboard IM Account

1. On the Blackboard IM Settings page, click the change email... link. The Change Email window opens.
2. Type your password in the Current password field.
3. Type the email address that you would like associated with your Blackboard IM account in the New Email field.
4. Re-type the desired email address in the Confirm New Email field.
5. Click the Save button. The Email changed confirmation page opens, indicating that your new email address has been set successfully.

**Note:**
The email address associated with your Blackboard IM account does not have to be a school email address or the email address associated with your CMS account.

To Change Your Security Question

1. On the Blackboard IM Settings page, click the change security question... link. The Change Security Question window opens.
2. Select a Security Question from the drop-down menu.
3. Type your response in the Answer field.
4. Click the Save button. The Security Question changed page opens, indicating that your security question has been successfully updated.

**To Change the Language Setting for Your Blackboard IM Account**

1. On the Blackboard IM Settings Page, click the Language drop-down menu.
2. Select the desired language.

**To Delete Your Blackboard IM Account**

1. On the Blackboard IM Settings page, click the Support link. The Blackboard IM Support page opens.
2. Click the Delete Your Account link. The Delete Your Account page opens.
3. Select a reason for deleting your Blackboard IM Account from the drop-down menu.
4. Add any additional comments in the Comments box.
5. Click the Continue button. The Confirm Delete page opens.
6. Type your Blackboard IM password in the Password field.
7. Click the Delete this account button. Your account is deleted.

---

**Note:**

Reasons for deleting your Blackboard IM account include if you are unhappy with your Blackboard IM ID or if you accidentally created more than one account.

---

**See Also:**

Accessing the Blackboard IM Settings Page
Modifying Your Course Settings
Language Settings

---

**Modifying Your Course Settings**

The Blackboard IM Settings page allows you to individually enable or disable Blackboard IM for each of your courses. This can be accomplished in the Course Settings area of the page.
**Course Settings: bb1.horizonwimba.com**

**General**
Checking the box under the General heading allows you to select whether Blackboard IM is automatically enabled for new courses in which you enroll. Keep in mind that this setting will remain in effect for future semesters.

**Course Participant**
The Course Participant section contains a list of all of the courses for which you can enable Blackboard IM. Check the box next to a course name to enable Blackboard IM or uncheck the box to disable it.

---

**Note:**
If Blackboard IM is disabled for a course, classmates will still be able to contact you. However, your name does not appear under the course name in their **Classmates** tab, and neither the course nor any classmates will appear in your **Classmates** tab. Effectively, it appears as if you are not enrolled in the course.

---

**Course Instructor (Displays for Instructors Only)**
This section is visible only if you are the instructor of a course. You have the option of enabling or disabling Blackboard IM for an entire course.

This setting will override the participant setting above. If a course is disabled, it will not appear in the participants' Classmates tab. However, Blackboard IM will still function, and participants will still be able to contact each other if they know each other's Blackboard IM ID or have each other saved in their **Contacts** tab.
Invitations

Instructors can invite members of their courses who have yet to register for Blackboard IM by following these steps:

1. Click the **Invite** link next to the desired course. The invitations page appears.

2. Click the box to the left of a user's name to include or exclude them from the invitation. You can click the **All** or **None** link below the **Select Users** box to select/deselect all users.

3. You can type an optional, custom message in the **Your Message** field, and then see how this message will appear in the email by clicking the **Preview** link. Your message will be incorporated into a template selected by your Blackboard IM Administrator.

**See Also:**
- Accessing the Blackboard IM Settings Page
- Modifying Your Account Settings
Inviting Users to Blackboard IM

**Note:** Your institution may have disabled invitations completely, may have disabled the ability to invite entire courses, or may have restricted those privileges to administrators or instructors.

You can send email invitations to fellow classmates to create a Blackboard IM account.

*To Invite Users to Blackboard IM*

1. In the Classmates Tab, locate your classmate's name under any course. Classmates who do not currently have Blackboard IM appear under the **Without Blackboard IM** sub-heading.

2. Double-click the desired user's name. (Alternatively, let the cursor hover over the name until an empty user profile appears, then click the **Invite to Blackboard IM** link.)
3. The **Invite User to Blackboard IM** window opens. You can type an optional personalized message in the **Your Message** text field.

![Invite User to Blackboard IM window](image)

4. Click **Invite**.

Your classmate is sent an email from your address with a link to the Blackboard IM registration page.

**Instructors**

Instructors can easily invite a course through one of the following methods:
• Click the envelope icon to the right of any Without Blackboard IM sub-heading.
• Click the gear icon to the right of any course name and select Invite Course to Blackboard IM. Only users who have yet to register for Blackboard IM receive an email invitation.
Chatting

About Chat
Chat is the simplest form of communication in Blackboard IM and, in many cases, it is also the most effective. Also known as instant messaging, Chat allows you to send a message, which is received immediately, to any user currently logged in to Blackboard IM. The user can then reply to your message and you can have a conversation via a series of instant messages.

Chat can also be used as a starting point for accessing Blackboard IM's more advanced features. For example, before starting a Call with someone, you may wish to send the user an instant message to make sure that they have a microphone connected.

Starting a New Chat
Before you can start a new Chat with someone, the user must first be in either your Contacts or Classmates tab. There are several ways to start a new Chat with a contact or classmate.

To Start a New Chat

1. Do one of the following in either the Contacts or Classmates tab:
   - Double-click the name of the user you wish to contact.
   - Select the name of the user you wish to contact and click [Chat Icon]


• Select the name of the user you wish to contact and press the **Enter** key on your keyboard.

• Select the name of the user you wish to contact and click **Chat** on the **Tools** menu.

A new Chat window opens.

![Chat Window](image)

2. Type your first message in the input area at the bottom.

3. Press the **Enter** key on your keyboard. The Chat session starts and your message is sent.

**See Also:**
The Chat Window
Ending a Chat

---

**The Chat Window**

The Chat window is where instant messaging conversations take place. When you start a new Chat, this window opens, showing you all of the messages that have been sent and allowing you to type new messages.
The Call Button

The Call button allows you to start a Call with the person with whom you are currently chatting. When you click the Call button, the other user receives a notification of an incoming call, and can then accept or reject the call.

It is possible to simultaneously use Calling and Chat with the same user; if you start a Call from the Chat window, your existing Chat remains open.

The Collaborate Button

The Collaborate button allows you to start a Collaboration session with the person with whom you are currently instant messaging. When collaborating, you can share applications, share a whiteboard, or view webpages together. When you click the Collaboration button, the other user receives an invitation to an Collaboration session, which he or she can then accept or reject.

It is possible to simultaneously use Chat and Collaboration with the same user; if you start a Collaboration from the Chat window, your existing Chat remains open.
The Profile Drawer Button
Clicking the Profile button reveals a drawer showing the user's profile information and current status. Clicking the button again hides the drawer.

The Message Area
The Message area displays all of the messages that have been sent between you and the other user. The user's name appears every time the sender of the message changes; the time that each message was sent is displayed along the right side of the window. You can use the scrollbars to see older messages not currently visible in the window.

Tip:
You can set Blackboard IM to automatically save the contents of the message area. See Enabling Automatic Message Log Saving.

The Text Input Area
The Text Input Area is where you type new messages.

- Messages are not visible to the other user until you press the Enter key on your keyboard to send them. Sent messages then appear in the Message Area.
- You can use the drop-down menu on the right side of the area to add emoticons to your message.
- To insert a new line in the message without sending the message, press Shift+Enter on your keyboard. (You can reverse the behavior of Enter and Shift+Enter in the General Preferences.)
- You can also use some HTML tags or emoticons.

Chat Tabs
Below the Text Input Area are the Chat tabs. These tabs show the name and status of the users with whom you are currently messaging. They also display the pencil icon when the other user is typing. This indication can be useful for helping you to avoid typing at the same time as another user. If you have multiple Chats open, each session is represented by a separate tab; clicking a tab brings the conversation into focus. Tabbed chat is enabled by default, but can be disabled in the Preferences window.

Tips:
- To cycle through tabs, press Ctrl+Tab on your keyboard (Windows) or Command+Left Arrow and Command+Right Arrow (Macintosh).
- To go to a specific tag, press CTRL+n where n is the number of the tab.
- You can rearrange the order of the tabs by dragging-and-dropping them.
See Also:
Starting a New Chat
Calling
Collaborating
Using Emoticons
Using URLs

Using Emoticons

Emoticons are special graphical icons that you can insert into any text-based chat to make your conversations more expressive and fun. The emoticons drop-down menu is located on the right side of the Text Input Area in all Chat windows.

To insert an emoticon into your message, you can either click the image in the drop-down menu, or type its key combination (which is displayed in the lower left-hand corner of the drop-down list).

Using HTML

You can also use certain HTML tags in chat.

For example, entering this in the text input area

```
We need to do it <i>now</i>.
```

results in this appearing in the message area.

```
Wendy Price
We need to do it now.
```

The table below lists all the supported tags.
<table>
<thead>
<tr>
<th>Tag</th>
<th>Effect</th>
<th>Example Input and Output</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;b&gt;</code> or <code>&lt;strong&gt;</code></td>
<td>Makes text boldface.</td>
<td>This is <code>&lt;b&gt;</code>bold<code>/b&gt;</code> and <code>&lt;strong&gt;</code>strong<code>&lt;/strong&gt;</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is <strong>bold</strong> and <strong>strong</strong>.</td>
</tr>
<tr>
<td><code>&lt;center&gt;</code></td>
<td>Centers text.</td>
<td><code>&lt;center&gt;</code>Summary<code>&lt;/center&gt;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Summary</strong></td>
</tr>
<tr>
<td><code>&lt;h1&gt;</code>, <code>&lt;h2&gt;</code>, <code>&lt;h3&gt;</code>, <code>&lt;h4&gt;</code>, <code>&lt;h5&gt;</code>, <code>&lt;h6&gt;</code></td>
<td>Creates a heading.</td>
<td><code>&lt;h1&gt;</code>Summary of Results<code>&lt;/h1&gt;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Summary of Results</strong></td>
</tr>
<tr>
<td><code>&lt;i&gt;</code> or <code>&lt;em&gt;</code></td>
<td>Makes text italicized.</td>
<td>This is <code>&lt;i&gt;</code>italicized<code>&lt;/i&gt;</code> and <code>&lt;em&gt;</code>emphasized<code>&lt;/em&gt;</code>.`</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is <em>italicized</em> and <em>emphasized</em>.</td>
</tr>
<tr>
<td><code>&lt;small&gt;</code> and <code>&lt;big&gt;</code></td>
<td>Changes the size of text.</td>
<td>This is <code>&lt;small&gt;</code>small<code>&lt;/small&gt;</code> and this is <code>&lt;big&gt;</code>big<code>&lt;/big&gt;</code>.`</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is small and this is big.</td>
</tr>
<tr>
<td>Tag</td>
<td>Effect</td>
<td>Example Input and Output</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&lt;sup&gt; &lt;/sup&gt; and &lt;sub&gt; &lt;/sub&gt;</td>
<td>Makes text superscripted or subscripted.</td>
<td>This is &lt;sup&gt;superscripted&lt;/sup&gt; and this is &lt;sub&gt;subscripted&lt;/sub&gt;. This is superscripted and this is subscripted.</td>
</tr>
</tbody>
</table>
| <table>, <td>, <tr> | Creates tables. | <table>
|              |                             | <tr>
|              |                             |  <td>Fruit</td> <td>Vegetables</td>  
|              |                             | </tr>
|              |                             | <tr>
|              |                             |  <td>Apples</td> <td>Cucumbers</td>  
|              |                             | </tr>
|              |                             | <tr>
|              |                             |  <td>Bananas</td> <td>Carrots</td>  
|              |                             | </tr>
|              |                             | </table>
|              |                             | ![Table Example](image)                                                                                                                                  |
| <ul>, <ol>, <li> | Creates bulleted or numbered lists. | <ul>
|              |                             | <li>This is a bulleted list, item one.</li>
|              |                             | <li>This is item two.</li>
|              |                             | </ul>
|              |                             |     ● This is a bulleted list, item one.                                                        |
|              |                             |     ● This is item two.                                                                         |
|              |                             | <ol>
|              |                             | <li>This is numbered list, item one.</li>
|              |                             | <li>This is item two.</li>
|              |                             | </ol>
|              |                             | 1. This is numbered list, item one.                                                             |
|              |                             | 2. This is item two.                                                                           |
|              |                             | ![List Example](image)                                                                            |

**Using URLs**

If you enter a URL in chat, it becomes a hyperlink that others can click on to view in their web browser.

There are also two special types of hyperlinks:

- links to YouTube videos
- links to Wikipedia articles
For these inks, you can click the icon beside the URL to view the webpage directly within chat.
Group Chat

About Group Chat
Group Chat is similar to regular Chat except that enables you to chat with multiple users at the same time.

You can invite new participants to a Group Chat either while creating it, or after the session has already been created. Any participant, including the creator of the Group Chat, can leave a session at any time and the other participants are still able to continue the session.

Starting a New Group Chat
Before you can start a new Group Chat, the users that you wish to invite to the session must first be in either your Contacts or Classmates tab. Once the desired users are either contacts or classmates, there are several ways to start a new Group Chat.

To Start a New Group Chat
1. Select at least one of the users that you wish to invite in either the Contacts or Classmates tab.
   - You can invite multiple users at the same time (you can always invite additional participants later).
   - To select multiple users, Ctrl-click (Windows) or Command-click (Macintosh) their names.
   - You can invite an entire course or Contacts group by right-clicking on the course or group title, or by clicking the gear icon ⚙️
2. Do one of the following:
   - Right-click (Ctrl-click on Macintosh) the name of one of the selected users and select **Invite to Group Chat > New Group Chat**.
   - Press **Ctrl+G** (Windows) or **Command+G** (Macintosh) on your keyboard.
   - Click **Tools menu > Group Chat > New Group Chat**.

   **Tips:**
   a) You can invite an entire course or Contacts group by right-clicking (Ctrl-Click on a Macintosh) on the course or group title, or by clicking the gear icon 🛠️.
   b) You can create an empty Invite to Group Chat window by choosing **Tools menu > Group Chat > New Group Chat** with no users selected, then drag and drop Contacts or Classmates into it.

   The **Invite to Group Chat** window opens.

   ![Invite to Group Chat Window](image)

3. Type a name for the session in the **Group Chat Name** field, or select the name of a previous Group Chat.

4. If you wish to invite additional participants, type their names in the Add Users field. The names that you type are automatically completed based on the names in your Contacts and Classmates tabs. Alternatively, you can drag and drop additional users from your Contacts or Classmates tab into the **Invite** box.

   Press **Enter** on your keyboard to add the user to the Invited list.
5. If you wish to remove a user from the Invite list, click the icon next to the user's name.

6. Click **Invite**. The new session is created, a Group Chat window opens, and invitations are sent to all of the users in the Invite list.

The Group Chat window provides the same functions as the regular Chat window. See the [Chat Window](#).

**Tips:**

a) You can return to a Group Chat by selecting **Recent Group Chats** from the Blackboard IM menu. This can be especially useful if you leave a Group Chat unintentionally.

b) You can start a new Group Chat based on a previously created session by selecting the name of the session (instead of **New Group Chat**) from the **Invite to Group Chat** menu, or from the drop-down menu in the **Invite to Group Chat** window. This preserves only the name of the session and does not allow you to see previously sent messages. It also does not automatically invite the users from prior sessions.

**See Also:**

Inviting New Users to a Current Group Chat
Inviting New Users to a Current Group Chat

At any time during a Group Chat, you can invite new users to join the session. You can invite a single user at a time or multiple users. Any current participant can invite new users, not just the creator of the session.

To invite a new user, drag and drop the name of the user anywhere in the Group Chat window. The user’s name appears with the pending icon 🔄 in the Participant List. This indicates that the user has received an invitation to join the session, but has not yet accepted it.

---

**Tip:**
An invitation can be canceled at any time before a user accepts it by hovering your cursor over the pending icon and clicking the x icon ✗ that appears. Only the person that invited a user can cancel his or her invitation.

---

See Also:
Starting a New Group Chat

---

Ending a Chat

To End a Chat

To end a chat, close the Chat window by doing either of the following:

- Press **Ctrl+F4** (Windows) or **Command-W** (Macintosh).
- Click the close button in the upper right-hand corner of the window.

If it was a group chat, other participants can still continue the chat after you leave.
Calling

About Calling

Note: Your institution may have disabled Audio and/or Video calling.

Calling can be used to make online communication more fluid and natural.
Calling differs from Chat in that you must call a user and wait for him or her to accept your invitation before your call can begin. You can also use Calling in combination with other Blackboard IM features such as Chat, Collaboration, and Office Hours.
A Call always uses audio. Optionally, it may also use video.

Audio
Also known as Voice over IP (VoIP), audio allows you to have a real-time audio conversation with any user currently logged in to Blackboard IM.

Video
Video on a Blackboard IM Call is unique because both participants do not need to have video capability in order to participate; using blended media, it is possible for one user to participate using video, while another user participates using only audio.
Requirements

To send your audio, you can use your computer's built-in microphone and standard headphones; but, for best call quality, it is recommended that you have a USB headset with an integrated microphone.

To send your video, you must have a supported video device (such as a webcam) either built-in or connected to your computer.

Starting a New Call

Before you can start a new Call with someone, the user must first be in either your Contacts tab or your Classmates tab.

If the user is currently in another call, you will not be able to call them until they finish their current call.

To Start a New Call

To start a new call, do one of the following:

- On the Contacts or Classmates tab
  
  - Select the name of the user you wish to call and click 📞.
  
  - Select the name of the user you wish to call and press Ctrl+K (Windows) or Command+K (Macintosh).
  
  - Select the name of the user you wish to call and choose Tools menu > Call > Invite to Call.

- On the window for a Chat with the user you wish to call

  - Click 📞.

The Audio & Video window opens. (And, if it is not already open, a Chat window for the user also opens.) Initially, the call only uses audio. To use video as well, click the Video button.
To Start a Group Call

To start a call with more than one other participant do the following:

1. Invite the other participants to a Group Chat.

2. On the Group Chat window, click .

See Also:
The Audio & Video Window
Ending a Call

The Audio & Video Window

The Audio & Video window opens when you accept a new incoming call, or when a call you start is accepted by another user.
The User Display Area
During an audio call, the User Display Area shows the first name and profile picture of the user with whom you are speaking. During a video call, it shows the video.

Microphone and Speaker Volume Bars
The Microphone and Speaker volume bars show the volume level of the incoming audio signal and the volume level of your outgoing audio signal.

The Talk Button
The Talk button allows you to control your outgoing audio. To talk, either click and hold the Talk button, or press and hold down the Ctrl key on your keyboard.

To lock the Talk button down, press Ctrl+T (Windows) or Command+T (Macintosh) on your keyboard. To unlock it, press Ctrl+T or Command+T again.

---

Note:
Unlike talking on a telephone, on a Call the other user cannot automatically hear you speak. You must use the Talk button or keyboard shortcuts to enable your outgoing audio.
Tip:
You can change the key used to hold down the **Push To Talk** button in the **Calls Preferences**.

The Video Button
To use video during the call, click **Video**.
(The Video button is only enabled if you have a webcam installed.)
While video is being displayed, you can move your cursor over the video preview to access these functions:

![Video Button](image)

- ![Thumbnail](image) toggles the thumbnail preview of your video
- ![FullScreen](image) toggles full-screen mode for the video
- ![Capture](image) saves a snapshot of the video (see **Video Capture** on next page)

The Options Menu
- The Options menu contains the following:
  - **Call Settings** - opens the **Calls Preferences**, allowing you to manage your audio devices and system audio settings.
  - **Preview** - toggles a thumbnail preview of your video.
  - **Full Screen** - toggles full-screen mode for the video.
  - **Video Capture** - saves a snapshot of the video.
  - **Collapse** - minimizes the window. Your video will still be transmitted.
  - **Close** - closes the window
See Also:
Starting a New Call

Video Capture

Video Capture allows you to capture a still image from a Video Call and either save it to your hard drive, or send it to an open Whiteboard session. To capture an image, select Video Snapshot from the Options drop-down menu.

From the Video Capture window, you can select whether you wish to capture Broadcast video only, Preview video only, or both. Then click the Save button to save the image to your hard drive or the Send to Whiteboard button to send the image to a Whiteboard session.

Note:
The Send to Whiteboard button is available only if the Collaboration window is open.

Ending a Call

To End a Call

To end the call, close the Call window by doing either of the following:
- Press **Ctrl+F4** (Windows) or **Command-W** (Macintosh).
- Click the close button in the upper right-hand corner of the window.

If it was a group call, other participants can still continue the call after you leave.
Collaborating

About the Collaboration Window
The Collaboration window enables you to exchange information ideas with others. You can share

- a whiteboard with drawings and presentations
- a region of your screen (via the Screen Sharing feature)
- websites (via the Web Tour feature)

Note:
Your institution may have disabled the Collaboration feature completely, or may have disabled the Screen Sharing and/or the Web Tour features.

Opening the Collaboration Window
To open the collaboration window, do one of the following:

- On the Contacts or Classmates tab
  - Select the name of the user you wish to call and press **Ctrl+Alt+C** (Windows) or **Command+Option+C** (Macintosh).
• Select the name of the user you wish to call and choose Tools menu > Collaborate > Invite to Collaborate.

• On a Chat, Group Chat, Office Hours, or Help Desk window, click

The Collaboration Window opens.

See Also:
Closing the Collaboration Window
The Collaboration Window

The Whiteboard Button

The Whiteboard button opens the Whiteboard where participants can share text, drawings, and presentations.
The Screen Sharing Button
The Screen Sharing button starts Screen Sharing, where participants can share a desktop or application on their computer.

The Web Tour Button
The Web Tour button starts a Web Tour, where participants can share websites.

Content Area
The content area shows the whiteboard, screen share, or web tour.
(The other items shown here are whiteboard-specific. See Using the Whiteboard below.)

See Also:
Using the Whiteboard
Using Screen Sharing
Using the Web Tour

Using the Whiteboard

About the Whiteboard
The Whiteboard is a collaboration tool that allows two or more users to synchronously view and modify objects and text on shared pages. Whiteboards are object-oriented, meaning that you can add and modify content independently of other objects on the page. This allows for virtually unlimited flexibility, control, and collaboration. You can use Whiteboards in conjunction with other Blackboard IM features, such as Chats, Calls, Office Hours, and Help Desks.

Whiteboard features include:

- tool color, stylization, and stroke options
- multiple pages with optional independent navigation
- clip art and backgrounds
- content import: .wwb, .wbd, .ppt, .pptx, .png, .jpg, .bmp, .gif
- whiteboard export: .wwb, .wbd, .pdf, .png, .jpg, .bmp
- video snapshot import from video calls
Starting a Whiteboard Session

To Start a New Whiteboard Session

1. If it is not already open, open the Collaboration Window.

2. On the Collaboration Window, click the Whiteboard Button. The Whiteboard opens.

See Also:
The Whiteboard Window

The Whiteboard Window
The Whiteboard window is where all of the actions of a Whiteboard session take place.
**Action Bar**

The Action Bar contains buttons that allow you to create new pages, delete the current page, clear the current page, undo the last action, and zoom in or out.

**Options Menu**

The Options menu provides access to the same commands as the Action Bar, as well as commands to modify objects.
The Load Content Button
The Load Content button lets participants upload content to the whiteboard.

Content Area
The content area is where you can draw, add text, and add objects in your Whiteboard session. It is also where uploaded content, such as a PowerPoint presentation, is shown.

Whiteboard Tools
The Whiteboard Tools allow you to draw, add text, and add shapes to a page. In addition, the Selection tool allows you to select and modify objects already on your page.

Tool Options
The Tool Options allow you to change the characteristics of the selected Whiteboard tool. They also allow you to change the appearance of existing objects.

Pages Ribbon (not shown)
The Pages Ribbon allows you to view and navigate through multiple pages in a Whiteboard session.

Gallery Ribbon
The Gallery Ribbon provides access to useful graphics and backgrounds to add to your Whiteboard session.

Navigation Controls
The navigation controls allow you to navigate through different pages in your Whiteboard session. By default, other users will also be moved to those pages. You can override this by using the Explore button.

Explore Button
The Explore button enables you to move to different whiteboard pages without other participants seeing those pages. While this button is pressed, you will also not see their navigation changes.
Whiteboard Tools

The Whiteboard Tools allow you to draw, highlight, add text, and add shapes to a page. In addition, the Select tool allows you to select and modify objects already on your page.

Note:
The following tools enable you to switch between variations by holding the tool button down:

- Pencil / Highlighter
- Filled Rectangle / Ellipse
- Unfilled Rectangle / Ellipse

Selection Tool

The Selection tool allows you to select and modify objects on a page. You can select more than one object at a time by holding down the Shift key while clicking on multiple objects. You can also rotate objects.
**Pointer**
The pointer enables you to point things out to other participants.

**Pencil**
The Pencil tool allows you to draw freeform objects on a page. Once you stop drawing with the Pencil, the line becomes an object that can be moved, scaled, and modified just like any other object in a Whiteboard, though the path of the line itself cannot be modified. Holding down the Shift key while drawing constrains the path of the Pencil to 90-degree angles.

**Highlighter**
The Highlighter tool allows you to emphasize content on a page by drawing a semi-transparent line. This can be especially useful for text, but can be used to highlight any object on a page. Holding down the Shift key while drawing constrains the path of the Highlighter to 90-degree angles.

**Text**
The Text tool allows you to add text to a page. Once you stop typing with the Text tool, the text becomes an independent object that can be moved, scaled, and modified just like any other object in a Whiteboard, though the text itself cannot be changed. You can change the font, font size, and style of the text using the Whiteboard Tool Options.

**Filled Rectangle**
The Filled Rectangle tool allows you to draw filled rectangles on a page by clicking and holding to set the rectangle's origin, dragging your mouse, and then releasing your mouse button to define its shape. Holding down the Shift key while dragging constrains the shape a square.

**Unfilled Rectangle**
The Unfilled Rectangle tool allows you to draw unfilled rectangles on a page by clicking and holding to set the rectangle's origin, dragging your mouse and then releasing your mouse button to define its shape. Holding down the Shift key while dragging constrains the shape a square.

**Filled Ellipse**
The Filled Ellipse tool allows you to draw filled ellipses on a page by clicking and holding to set the ellipse's origin, dragging your mouse, and then releasing your mouse button to define its shape. Holding down the Shift key while dragging constrains the shape a circle.
**Unfilled Ellipse**

The Unfilled Ellipse tool allows you to draw unfilled ellipses on a page by clicking and holding to set the ellipse's origin, dragging your mouse, and then releasing your mouse button to define its shape. Holding down the Shift key while dragging constrains the shape a circle.

**Line**

The Line tool allows you to draw straight lines on a page by clicking and holding to set the line's starting point, dragging your mouse, and then releasing your mouse button to set the line's end point. Holding down the Shift key while drawing constrains the path of the Line tool to 45-degree angles.

**See Also:**
- Modifying Objects on a Whiteboard
- Whiteboard Tool Options
- The Whiteboard Gallery Ribbon

**Whiteboard Tool Options**

The Tool Options allow you to change the appearance of shapes and text.

If you have an object currently selected on the page, changing these options affects only that object. If you have a tool selected, changing these options affects new shapes drawn with that tool.

The available options vary slightly depending on what tool or object is currently selected.

- **(Highlighter)**
- **(Pencil)**
- **(Line, Unfilled Rectangle, Unfilled Ellipse)**
- **(Arrow, Filled Rectangle, Filled Ellipse)**
- **(Text)**

**Color**

This control enables you to change the color.
**Stylize**
This control enables you to modify most shapes.

- It adds a drop shadow to Arrow, Pencil, Text, Line, Unfilled Rectangle, and Unfilled Ellipse shapes.
- It adds a gradient to Filled Rectangle and Filled Ellipse shapes.

**Opacity**
This control enables you to change the opacity (from solid to transparent).

**Stroke**
This control enables you to modify the line thickness of objects created with the Highlighter, Pencil, Line, Unfilled Rectangle, and Unfilled Ellipse tools.

**Text Tool Options**
This control enables you to modify text's font, size, and style.

**See Also:**
- Modifying Objects on a Whiteboard
- Whiteboard Tools

---

**Modifying Objects on a Whiteboard**
There are several different ways to modify an object.

**To Move an Object**

1. Click the Selection tool.
2. Click the desired object on the page.
3. Click and drag the center of the object to the desired location.
4. Release your cursor.

**To Modify the Size or Shape an Object**

1. Click the Selection tool.
2. Click the desired object on the page.
3. Click and drag one of the handles to modify the size, shape, or rotation of the object.

![Object Modification](image)

4. Release your cursor.

**(To Rotate an Object)**

1. Click the Selection tool.
2. Click the desired object on the page.
3. Move the cursor near one of the corner handles until it becomes a curved double-headed arrow.

![Object Rotation](image)

4. Drag to rotate the object.
5. Release your cursor.

**(To Modify the Appearance of an Object)**

1. Click the Selection tool.
2. Click the desired object on the page.
3. Make the desired changes to color, stylize, and tool options.
To Change the Arrangement of an Object

1. Click the Selection tool.  
2. Right-click (Windows) or Ctrl-click (Macintosh) the desired object on the page. The contextual menu appears.  
3. Select one of the following:  
   - **Send to Back** to arrange the object behind all other objects on the page.  
   - **Bring to Front** to arrange the object in front of all other objects on the page.  

To Change the Grouping of an Object

1. Click the Selection tool.  
2. Select more than one object on the page by either Shift-clicking or dragging your cursor around multiple objects to select them.  
3. Right-click (Windows) or Ctrl-click (Macintosh) one of the selected objects.  
4. Select one of the following:  
   - **Group** to group all of the selected objects together so that they can be modified together.  
   - **Ungroup** to ungroup the selected objects so that they can be modified independently.  

To Delete an Object

1. Click the Selection tool.  
2. Press the **Delete** key on your keyboard.

The Whiteboard Gallery Ribbon

The Whiteboard Gallery Ribbon provides access to useful graphics and backgrounds which you can add to your Whiteboard session.
**Backgrounds**

You can select a new background for a page by clicking it in the Gallery ribbon. Backgrounds always remain behind all other objects on a page and cannot be modified. To clear the background of a page, click the Blank Page background.

**Gallery Objects**

The Gallery objects categories contain useful graphics that you can add to a page. You can move, scale, and rotate Gallery objects in the same way as objects created with the Whiteboard tools. The Gallery object categories are:

- Common
- Clip Art
- Shapes
- Flowchart
- Math Operators
- Math Relations
- Logic
- Greek Upper Case
- Greek Lower Case
- Statistics
- Music
- Astronomy

**The Stamp Tool**

If you wish to add the same Gallery object to a page more than once, click the object twice until the plus symbol (+) appears. You can then use the stamp tool and click on the page wherever you want to add the object.
To open the gallery, press the Gallery button on the whiteboard.

**See Also:**
Modifying Objects on a Whiteboard

---

**Loading Content into a Whiteboard**

You can load content from your computer into a Whiteboard session or import previously saved Wimba Whiteboard, Blackboard Collaborate web conferencing Whiteboard, or Elluminate Live! Whiteboard session archives. The supported import file types are:

- .wwb (Wimba Whiteboard)
- .wbd (Blackboard Collaborate web conferencing and Elluminate Live! Whiteboard)
- .ppt
- .pptx
- .png
- .jpg
- .bmp
- .gif

When you import .wwb, .wbd, .ppt, or .pptx files, they are added to the Whiteboard as separate pages. When you import .png, .jpg, .bmp, or .gif files, they are added to the current page as objects.

**To Load Content into a Whiteboard**

1. Do one of the following:
   - Click **Load Content**.
   - Or, click **Load Content** on the Action Bar Menu.
     The Import File window opens.
2. Select the desired content from your hard drive.
3. Click the **Open** button. The content is imported to the Whiteboard.

**See Also:**
Known Limitations for Importing Whiteboards
Saving Whiteboards
**Known Limitations for Importing Whiteboards**

When importing WBD Files (Blackboard Collaborate web conferencing and Elluminate *Live!* Whiteboards), the following are known limitations. They are due to the different features that are supported in Blackboard Collaborate web conferencing:

- Only the .WBD file format is supported, not .WBP.
- Backgrounds are imported as regular objects, not as backgrounds.
- External links are not supported. (They are formatted to look like regular text, not like hyperlinks.)
- Dashed lines are imported as solid lines.
- Objects that are filled *and* have outlines are imported as filled objects. They do not have outlines.
- Fonts are mapped as follows:

<table>
<thead>
<tr>
<th>Original Font</th>
<th>Imported Font</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialog</td>
<td>Arial</td>
</tr>
<tr>
<td>SansSerif</td>
<td>Verdana</td>
</tr>
<tr>
<td>Serif</td>
<td>Times</td>
</tr>
<tr>
<td>Monospaced</td>
<td>Courier</td>
</tr>
<tr>
<td>DialogInput</td>
<td>Arial</td>
</tr>
</tbody>
</table>

  - Imported text uses the closest font size that is supported in Blackboard IM.
  - For scrolling text boxes, only the text is imported (not formatting or word wrapping).
  - The position of Text or Multi-line text objects may be slightly different after import.
  - Image frames are not imported.
  - Animated GIFs are imported as static images.
  - Objects in the original whiteboards may have nested grouping. (In other words, a group of objects can contain objects which are themselves groups.) When imported into Blackboard IM, the objects are still grouped, but they are all grouped at the same level. There are no sub-groups.

**Saving Whiteboards**

You can save Whiteboard content for offline viewing or archiving purposes. Both single pages and entire Whiteboards (containing all of the pages in the session) can be saved in a variety of formats. If you save an entire Whiteboard in .wwb (Wimba Whiteboard archive) format, you can import it to another Whiteboard to continue the session at a later time. Single pages and entire Whiteboards can be saved in the following formats:
To Save an Entire Whiteboard

1. Click the **Save** button in the **Action Bar**. The Save to File window opens.
2. Select the location on your hard drive where you wish to save the Whiteboard.
3. Select the desired file type from the drop-down menu.
4. Click the **Save** button.

To Save a Single Whiteboard Page

1. Navigate to the page you wish to save.
2. Click the **Save Page** button in the Action Bar. The Save Page to file window opens.
3. Select the location on your hard drive where you wish to save the page.
4. Select the desired file type from the drop-down menu.
5. Click the **Save** button.

**See Also:**
- Loading Content into a Whiteboard
- Known Limitations for Exporting Whiteboards

**Known Limitations for Exporting Whiteboards**

When exporting WBD Files (Blackboard Collaborate web conferencing and Elluminate Live! Whiteboards), the following are known limitations. They are due to the different features that are supported in Blackboard Collaborate web conferencing.

- Gradients in objects are not preserved. This affects shapes (solid and hollow), lines, and text.
- Rotation of objects and text is not preserved. (Rotated lines *do* preserve their rotation.)
- Multi-line text is exported as a text box with a single color and single font. Transparency is not supported. (Transparency is supported for other objects.)
- Images may be sized incorrectly. And transparency is not supported.
- Clip art may not appear in the correct position and may appear pixelated.
- Some clip art (such as the music notes) only displays the borders of the shape.
- The highlight pen has a different line end shape.

**Whiteboard Action Tracking**

To find out which user created or last modified an object, right-click (Windows) or Ctrl-click (Macintosh) the object to show the contextual menu. The 'Created By' and 'Last Modified By' fields are located at the bottom of the contextual menu.

![Contextual Menu]

See Also:
Modifying Objects on a Whiteboard

**The Whiteboard Action Bar**

The Whiteboard Action Bar contains buttons that allow you to save and import content, create new pages, clear the current page, and undo the last action.

![Action Bar]

**Note:** This bar appears when you move the mouse cursor over the Whiteboard button.
New Page
Adds a new page to the Whiteboard session.

Clear Page
Clears all objects from the current page.

Remove Page
Deletes the current page.

Size
Zooms the page in or out.

Options Menu
Contains some of the above commands plus the following:

- **Save** - Saves all the pages, in your choice of a variety of formats.
- **Save Page** - Similar to Save, but saves only the current page.
- **Import** - Allows you to import PowerPoint files, images, and saved Whiteboard archives into the Whiteboard session.
- **Undo** - Reverses the last action preformed on the current page.
- **Cut** - Removes the current object(s) and puts it on the clipboard.
- **Copy** - Copies the current object(s) to the clipboard.
- **Paste** - Pastes the current object(s) to the whiteboard from the clipboard.
- **Delete** - Deletes the object(s) without placing them on the clipboard.
- **Select All** - Selects all objects on the page.
- **Group** - Groups the selected objects so they can be manipulated (moved, resized, rotated, duplicated, etc.) as one object.
- **Ungroup** - Splits a grouped object into its constituent parts.
- **Duplicate** - Makes a copy of the selected object(s).
- **Send to Back** - Sends the selected object(s) behind other objects.
- **Bring to Front** - Brings the selected object(s) in front of other objects.
Using Screen Sharing

About Screen Sharing
Screen Sharing allows you to share a live view of a portion of the screen on your computer with other Blackboard IM users. When you host a Screen Sharing session, other users can see your screen just as if they were physically sitting at your computer. Because you can share virtually any application on your computer, the possibilities for collaboration are endless. You can choose exactly how much and which part of your screen you want to display. You can also give another user cursor and keyboard control of your desktop, allowing them to control and modify anything displayed on your screen.

Note:
Your institution may have disabled the Screen Sharing feature.

Starting Screen Sharing

To Start Screen Sharing

1. If it is not already open, open the Collaboration Window.
2. On the Collaboration Window, click .

The Screen Sharing window opens.

See Also:
The Screen Sharing Window

The Screen Sharing Window

The Screen Area Frame
This resizable frame controls how much of your screen is displayed to other users; only the area contained within the box is shared. You can move the frame around by dragging any of the dashed edges and resize it by grabbing one of the eight control points located at the corners and on each side of the box.
The Action Bar

The Action Bar contains the following controls:

- **Cursor** lets you grant cursor and keyboard control of the shared area to anyone currently in your Screen Sharing session. The drop-down list contains the names of all of the current participants.
- **Remove Control** gives you back control over the cursor and keyboard.
- **Stop Sharing** ends the current Screen Sharing session.
Note:
Because granting Cursor and Keyboard privileges gives a user full control of your computer, be sure to not leave a Screen Sharing session unattended when someone else has control.

See Also:
Starting Screen Sharing

Using the Web Tour

About the Web Tour
The Web Tour enables you to share Internet sites with other people in the Collaboration Window.

Note:
Your institution may have disabled the Web Tour feature.

Starting a Web Tour

To start a Web Tour

1. If it is not already open, open the Collaboration Window.

2. On the Collaboration Window, click the Web Tour button. The Web Tour opens.

See Also:
Using the Web Tour
Using the Web Tour

- **If you have Follow Me checked**
  Enter the URL of the webpage in the address field in the Action Bar. Other participants will automatically be shown the webpage you are viewing.

- **If you clear Follow Me**
  You can navigate to a different webpage and other participants will not see that page. But your webpage will be overwritten if the person with Follow Me navigates to another webpage.
Any user can select Follow Me at any time in order to take control. Only one person can have Follow Me checked.

**Note:**
For security, if you have Follow Me checked and you navigate to a password-protected webpage (such as web-based email for example), other users will not see any content beyond the login page.
If you wish to share password-protected content, use Screen Sharing.

You can use the Options menu in the Action Bar to copy the URL the current webpage to the chat.

See Also:
Starting a Web Tour

**Closing the Collaboration Window**

Close the window by doing either of the following:

- Press **Alt+F4** (Windows) or **Command-W** (Macintosh).
- Click the close button in the upper right-hand corner of the window.

Other participants can still continue to use the window after you leave.
Using Web Conferencing

About Web Conferencing
Blackboard Collaborate Web Conferencing provides a full online classroom. Features include the ability to

- create breakout rooms for smaller groups
- record sessions for later review
- plan sessions ahead of time

Note:
For more information about web conferencing, see the Blackboard Collaborate Web Conferencing Moderator’s Guide and Participant’s Guide.

Note:
Your institution may have disabled the Web Conferencing feature.
Starting a Web Conference

**Note:**
Your institution may have enabled only instructors to start Web Conferencing.

Before you can start a new web conference with someone, the user must first be in either your Contacts tab or your Classmates tab.

*To Start a Web Conference*

To start a new conference, do one of the following:

- On the Contacts or Classmates tab, select the name(s) of the user(s) you wish to invite to the conference and do any of the following:
  - Click.
  - Press Ctrl+U (Windows) or Command+U (Macintosh).
  - Choose Tools menu > Conference > Invite to Web Conference.

The Invite to Blackboard Collaborate web conference window opens.
1. If you wish to invite additional participants, type their names in the Add Users field. The names that you type are automatically completed based on the names in your Contacts and Classmates tabs. Alternatively, you can drag and drop additional users from your Contacts or Classmates tab into the Invite box.

Press Enter on your keyboard to add the user to the Invited list.

2. If you wish to remove a user from the Invite list, click the icon next to the user's name.

3. Click Launch. The new conference is launched and invitations are sent to all of the users in the Invite list.

By default, in the web conference you are a moderator (a participant with full privileges) and all the people you invite are attendees with limited privileges. You can promote other attendees to be moderators from within the conference.

**Viewing Recordings**

While in a web conference, moderators can record the session.

*Getting notified of recordings*

If you are a moderator, you will receive a message from the system when the recording is available. You can send that URL to anyone to allow them to view the recording (regardless of whether they were a participant in the web conference).
To view recordings of web conferences in which you were a participant

1. Choose **Tools > Conference > View Recordings**.
2. Choose the name of the institution (you may only have one).
3. A webpage opens with the list of available recordings. You can play the recordings from this page.

**Note:**
From the time the recording is stopped, it takes a few minutes for the recording to become available.
Using Office Hours

About Office Hours

Office Hours takes the concept of Group Chat one step further by creating a waiting room in which users line up to speak to the owner in the order that they enter the chat. It is especially useful for situations in which an instructor needs to communicate with multiple users in a structured setting.

Unlike other types of chat in Blackboard IM, Office Hours has multiple chat areas – the Main Room and the Waiting Room – and a new owner (or moderator) role to regulate the participation of the other users. When you start Office Hours, you automatically become the owner of the session. Your status is then displayed to other users as Office Hours and they can join your session. Depending on the settings defined when you create the session, you can either choose to have the first person in line automatically promoted to the Main Room, or choose to promote and demote participants manually. You can also Call and Collaborate, directly from the Office Hours window.

The Office Hours Views

Since there are different roles in Office Hours – host and participants – there are different windows for the different views that users see, depending on these roles and their current status. The three Office Hours windows are: the Office Hours Owner window, the Waiting Room window, and the Main Room Participant window.
The Office Hours Owner Window

This is the view that the host of an Office Hours session always sees. In addition to the Message Area, it contains lists of all of the participants both in the Main Room and in the Waiting Room. If Waiting Room chat is enabled, you can also choose to display those messages in this window.
The Waiting Room Window

This is the view that participants see when they are in the Waiting Room, when they have joined an Office Hours session, but have not yet been promoted to the Main Room. In this window, users may or may not be able to send messages to each other, depending on whether Waiting Room chat is enabled.
The Main Room Participant Window

This is the view that participants see once they have been promoted to the Main Room. It is similar to the Office Hours Owner window, but does not contain options for promoting and demoting users and does not show the Waiting Room list or Waiting Room chat. This window is also similar to the Group Chat window.

See Also:
The Office Hours Owner Window
The Waiting Room Window
The Main Room Participant Window

For Owners

Starting a New Default Office Hours Session

The process for starting a new Office Hours session is different than for other types of chat in Blackboard IM because you don’t have to invite other users. Instead, you set your status to Office Hours and other users can contact you by joining your session.
To Start a New Default Office Hours Session

1. Click the Status Bar.

2. Select Office Hours. Your status changes to Office Hours and a new Office Hours window opens.

Default Settings for Office Hours

When you select Office Hours from the Status Bar, you are not asked to define settings for the session; instead, your session begins using the default settings. The default Office Hours settings are as follows:

- Title: *User's First Name's Office Hours*
- Waiting Room Chat: Enabled
- Automatic Promotion: Enabled
- Allow Office Hours messaging only: Disabled
- Require reason for entering: Enabled
- Prompt for reason for entering: Please provide a topic for discussion.
- Greeting for the waiting room: None

See Also:
Starting a New Custom Office Hours Session
Joining an Office Hours Session

Starting a New Custom Office Hours Session

Starting a custom Office Hours session is similar to starting a default Office Hours session, except that you are given the option to define custom settings for the session.
To Start a New Custom Office Hours Session

1. Click the Status Bar.
2. Select Custom below Office Hours. The Edit Custom Status window opens.
3. Select the desired settings for your Office Hours session:
   - **Title** allows you to set a custom name for the session (and your status).
   - **Enable waiting room chatting** allows you to set whether the Waiting Room is anonymous; if unchecked, Waiting Room participants cannot communicate or see each other's identities.
   - **Automatic promotion** allows you to set whether or not the next user in line is automatically promoted when the Main Room is empty.
   - **Allow Office Hours messaging only** allows you to set whether or not users can send you instant messages outside of your Office Hours while you are hosting a session.
   - **Require reason for entering** allows you to set whether users entering the Office Hours session must give a reason for joining. You can also modify the message that prompts users to enter their reason.
   - **Greeting for the waiting room** allows you to create an optional greeting that is displayed to users upon entering the Waiting Room.
   - **Save for future use** allows you to save the current settings for the custom Office Hours session so that you can easily access it in the future.

4. Click **OK**. Your status changes to the title you chose in Step 3 and a new Office Hours window opens.

---

**Note:**
If you check the **Office Hours messaging only** box, you cannot receive instant messages from other users while hosting an Office Hours session. When a user attempts to contact you, a notification is displayed saying that you are currently hosting Office Hours and may not have received the message. However, there is no way for other users to know whether or not you are accepting interruptions and, therefore, no way for them to know whether or not you received their message.

---

**See Also:**
- Starting a New Default Office Hours Session
- Joining an Office Hours Session

---

**The Office Hours Owner Window**
The Office Hours Owner window is the view that the owner of an Office Hours session always sees. In addition to the Message Area, it contains lists of all of the participants both in the Main Room and in the Waiting Room and controls for managing the promotion and demotion of users.
The Call Button
The Call button allows you to start a Call with the participants currently in the Main Room. When you click Call, all participants in the Main Room receive a notification, which they can then individually accept or reject. If you start a Call from an Office Hours session, the Main Room window remains open. All participants do not have to accept the Call invitation for it to function, but only those who do are able to participate in it.

The Collaborate Button
The Collaborate button opens the Collaborate Window with the participants currently in the Main Room. When you click Collaborate, all participants in the Main Room receive a notification, which they can then individually accept or reject. If you open a Collaborate Room from an Office Hours session, the Main Room window remains open. All participants do not have to accept the Collaborate invitation for it to function, but only those who do are able to participate.
in it.

**The Show Waiting Room Chat Button**
The Show Waiting Room Chat Button allows you to toggle the display of chat between the users in the Waiting Room. Clicking this button reveals the Waiting Room Chat Display below the Text Input area.

**The Profile Drawer Button**
The Profile button shows the profile picture of the last user in the Main Room to type a message or speak (if you are using Audio or Video Calling). Selecting a user from one of the Participant Lists shows the user's profile picture for 15 seconds. Clicking the Profile button reveals a drawer showing the user's profile information and current status. Clicking the button again hides the drawer.

**The Message Area**
The Message Area displays all of the messages that have been sent between the participants in the Main Room. The user's name appears every time the sender of the message changes; the time that each message was sent is displayed to the right of the message. You can use the scroll-bars to see older messages not currently visible in the window.

**The Main Room Participant List**
The Main Room Participant List displays the names, Blackboard IM IDs, and statuses of all of the users currently in the Main Room. The list also shows whether a user is currently using Audio Calling, Video Calling, Screen Sharing, or Whiteboard. You can right-click (Ctrl-click on Macintosh) the name of a participant to access the user's profile, webpages, and email link, or to remove the user from the Office Hours Session. The pencil icon 🖋 is displayed next to the names of users that are currently typing a message. This indication can be useful for helping you to avoid typing at the same time as another user.

**The Promote/Demote Button**
The Promote/Demote button is used for promoting users from the Waiting Room to the Main Room, or demoting users from the Main Room to the Waiting Room.

**The Waiting Room Participant List**
The Waiting Room Participant List displays the names, Blackboard IM IDs, statuses, and time waiting of all users currently in the Waiting Room. The text below the user's name also displays his or her reason for entry. The pencil icon 🖋 is displayed next to the names of users that are
currently typing a message. You can right-click (Ctrl-click on Macintosh) the name of a participant to access the user's profile, webpages, and email link, as well as to promote the user to the Main Room or remove the user from the Office Hours session. Above the Participant List is the Automatic Promotion check box, which allows you to enable or disable the automatic promotion to the Main Room of the first user in line when the Main Room is empty.

**The Send Button**

The Send button lets you send a message to all users in the Waiting Room. Users in the Main Room cannot see messages that you send to the Waiting Room.

**The Text Input Area**

The Text Input area is where you can type new messages to all users in the Main Room. Messages are not visible to other users until you press the **Enter** key on your keyboard to send them. Sent messages then appear in the Message Area. Users in the Waiting Room cannot see messages that you send to the Main Room.

**The Waiting Room Chat Display**

If you have enabled the Waiting Room Chat display, this area shows all of the messages sent between users in the Waiting Room.

**See Also:**
- The Office Hours Views
- The Main Room Participant Window
- The Waiting Room Window

**Promoting a Participant to the Main Room**

Promoting is the method used by the owner of an Office Hours session to move users from the Waiting Room to the Main Room. Although you can use Automatic Promotion to manage this process, you also have the option of manually promoting a user at any time.

*To Promote a Participant to the Main Room*

1. Click the name of the user that you wish to promote in the Waiting Room Participant List.
2. Click the **Promote** button. The user is promoted to the Main Room.

**Tip:**
You can promote as many users as you wish to the Main Room. This can be useful if you see that multiple users in the waiting room wish to discuss the same topic.

**See Also:**
Demoting a Participant to the Waiting Room
The Office Hours Owner Window

**Demoting a Participant to the Waiting Room**
The owner of an Office Hours session has complete control over which users have access to the Main Room and can choose to demote a user to the Waiting Room at any time. This feature is especially useful if Automatic Promotion is enabled and a user was promoted earlier than the owner wished.
To Demote a Participant to the Waiting Room

1. Click the name of the user that you wish to demote in the Main Room Participant List.

2. Click the **Demote** button. The user is demoted to the Waiting Room.

**Note:**
If you demote a participant to an empty Waiting Room, you must have Automatic Promotion disabled to prevent the user from automatically returning to the Main Room. You can also remove the user from the Office Hours session.

**See Also:**
Promoting a Participant to the Main Room
Removing a Participant from an Office Hours Session
The Office Hours Owner Window
Removing a Participant from an Office Hours Session

In addition to promoting and demoting users, the owner of an Office Hours session can also remove a user from the session altogether. This feature can be useful if a user is idle as a result of having left his or her computer. You can remove users from both the Main Room and the Waiting Room.

To Remove a Participant from an Office Hours Session

1. Right-click (Ctrl-click on Macintosh) the name of the user in either the Main Room or Waiting Room Participant List.

2. Select Remove User Name. The user is removed from the Office Hours session.

---

Note:
You do not need to give a reason for removing a participant from an Office Hours session. When removed, the user receives a message that says: **You have been removed from Title of Office Hours Session.**
See Also:
Promoting a Participant to the Main Room
Demoting a Participant to the Waiting Room
The Office Hours Owner Window

Viewing Waiting Room Chat

If Waiting Room chat is enabled, participants waiting to enter the Main Room can send messages back and forth amongst themselves. The owner of the Office Hours session may wish to view the messages being sent in the Waiting Room, which can be done by enabling the Waiting Room Chat Display in the Office Hours Owner window.

To toggle the display of the Waiting Room Chat Display, click the Show/Hide Waiting Room Chat button in the Office Hours Owner window.

![Waiting Room Chat Display](image-url)
**Note:**
Only the owner of an Office Hours session can view Waiting Room Chat; other participants in the Main Room never see messages being sent in the Waiting Room.

**See Also:**
The Office Hours Owner Window
Sending a Message to the Waiting Room

**Sending a Message to the Waiting Room**

While the owner of an Office Hours session cannot enter the Waiting Room and participate directly in chat between participants, the owner can send messages to the Waiting Room. These messages are visible to all waiting users, but cannot be seen by Main Room participants. The owner can send a message to the Waiting Room even if Waiting Room chat is disabled. This feature is especially useful for telling waiting users that you will be ending the Office Hours session.

*To Send a Message to the Waiting Room*

1. Click the **Send...** button below the Waiting Room Participant List in the Office Hours Owner window. The Message window opens.
2. Type your message in the text box.
3. Click **Send**. Your message is sent to the Waiting Room.

**See Also:**
- Viewing Waiting Room Chat

**Ending an Office Hours Session**

Unlike Group Chat, Office Hours is dependent on a single user (the owner) and cannot continue indefinitely if the owner leaves the session. This is just like when a professor ends office hours and leaves his or her office. When the owner leaves an Office Hours session, a five-minute countdown begins. During this time, any participants remaining in the Main Room or in the Waiting Room can continue to communicate and use features such as Audio Calling, Video Calling, and Screen Sharing. Just as if the owner was present, however, users in the Main Room cannot communicate with users in the Waiting Room (and vice versa). Within five minutes of leaving the Office Hours session, the owner can return (by selecting the title of the chat from the Status Bar) and the Office Hours session continues. If the owner does not return within five minutes, the session ends, all users are removed from the Office Hours session and the window closes.

**To End an Office Hours Session**

Do one of the following:

- Close the Office Hours Owner Window.
- Change your status in the Status Bar to a non-Office Hours status.

  a. If there are participants in the Waiting Room, the Close Office Hours window opens and gives you the option to send a message to the Waiting Room. Do one of the following:

      - Type a message in the text box and click **Send**.
      - Click **Don’t Send** to end the Office Hours session without sending a message.

  ![Close Office Hours](image)

  b. If there are no participants in the Waiting Room, a dialog appears asking you if you are sure that you want to close Office Hours. Click **Close**.
For Participants

Joining an Office Hours Session
Anytime a user starts an Office Hours session, his or her status displays as Office Hours. You can join an Office Hours session similarly to how you would send the user an instant message, but instead of starting a new Chat, you enter the user's Office Hours session.

To Join an Office Hours Session

1. Do one of the following:
   - Double-click the name of the user whose Office Hours you wish to join.
   - Select the name of the user whose Office Hours you wish to join and press the Enter key on your keyboard.

   A new Chat window opens, displaying a notification that the user is currently holding Office Hours.

2. Click the Join button. If the owner of the session has not requested that you provide a reason for joining, a new Office Hours window opens and you are added to the waiting room.

   If the owner of the session has requested that you provide a reason for joining, a new window opens, prompting you for this information:
3. Type your reason for joining in the box.

4. Click OK. A new Office Hours window opens and you are added to the waiting room.

   **Note:**
   If the host of the Office Hours session has enabled automatic promotion, and you are the next person in line, you automatically join the Main Room.

   **See Also:**
   The Main Room Participant Window
   The Waiting Room Window

**The Waiting Room Window**

The Waiting Room window is what users see when they have joined an Office Hours session, but have not yet been promoted to the Main Room.

The room can be configured by the instructor to show the names of attendees, or it may be anonymous so users do not see each other's identities.
The Profile Drawer Button

Unless the Waiting Room is anonymous, the Profile Drawer button shows the profile picture of the last user to type a message, or any user that is selected in the Participant List. Clicking this button reveals a drawer showing the user's profile information and current status. Clicking the button again hides the drawer.

The Message Area

If Waiting Room Chat is enabled, the Message Area displays all of the messages that have been sent between the participants in the Waiting Room. The user's name appears every time the sender of the message changes; the time that each message was sent is displayed to the right of the message. You can use the scrollbars to see older messages (sent since you entered) not currently visible in the window. If Waiting Room Chat is disabled, the Message Area only displays a greeting and any other messages sent by the owner.
The Waiting Room Participant List

Unless the room is anonymous, the Waiting Room Participant List displays the names, Blackboard IM IDs, statuses, and reasons for joining the session (if required) for all users currently in the Waiting Room. The list also shows your current place in line. You can right-click (Ctrl-click on Macintosh) the name of a participant to access the user's profile, webpages, and email link. The pencil icon 🖋️ is displayed next to the names of users that are currently typing a message. If the Waiting Room is anonymous, the names of the other users waiting are displayed as Participant <#>. You can still see how many participants are currently waiting, as well as how long they have been waiting, but there is no way to know their identities or to communicate with them.

The Text Input Area

If Waiting Room chat is enabled, the Text Input area is where you can type new messages. Messages are not visible to other users until you press the Enter key on your keyboard to send them. Sent messages then appear in the Message Area. You can also use the drop-down menu on the right side of the Text Input area to add emoticons to your message. If Waiting Room chat is disabled, the Text Input area displays a message informing you that chat is not allowed in anonymous rooms.

See Also:
The Office Hours Views
The Office Hours Owner Window
The Main Room Participant Window

The Main Room Participant Window

The Main Room Participant window is the view that participants see once they have been promoted to the Main Room. Although similar to the Office Hours Owner window, the Main Room Participant window does not contain options for promoting and demoting users, and does not show the Waiting Room list or chat. The Main Room Participant window is similar to the Group Chat window.
The Call Button
The Audio Call button allows you to start a Call with the participants currently in the Main Room. When you click the Call button, all participants in the Main Room receive a notification, which they can then individually accept or reject. It is possible to simultaneously use Calling and Chat; if you start a Call from an Office Hours session, the Main Room window remains open. All participants do not have to accept the Call invitation for it to function, but only those who do are able to participate in it.

The Collaborate Button
The Collaborate button opens the Collaboration Window with the participants currently in the Main Room. When you click Collaborate, all participants in the Main Room receive a notification, which they can then individually accept or reject. If you open a Collaborate Room from an Office Hours session, the Main Room window remains open. All participants do not have to accept the Collaborate invitation for it to function, but only those who do are able to participate in it.
The Profile Drawer Button

The Profile button shows the profile picture of the last user in the Main Room to type a message or speak (if you are using Audio or Video). Selecting a user from the Participant List shows the user's profile picture for 15 seconds. Clicking the Profile button reveals a drawer showing the user's profile information and current status. Clicking the button again hides the drawer.

The Message Area

The Message Area displays all of the messages that have been sent between the participants of in the Main Room. The user's name appears every time the sender of the message changes; the time that each message was sent is displayed to the right of the message. You can use the scroll-bars to see older messages (sent since you entered) not currently visible in the window.

The Main Room Participant List

The Main Room Participant List displays the names, Blackboard IM IDs, and statuses of all of the users currently in the Main Room. The list also shows whether a user is currently using Audio Calling, Video Calling, Screen Sharing, or Whiteboard. You can right-click (Ctrl-click on Macintosh) the name of a participant to access the user's profile, webpages, and email link. The pencil icon ✏️ is displayed next to the names of users that are currently typing a message. This indication can be useful for helping you to avoid typing at the same time as another user.

The Text Input Area

The Text Input area is where you can type new messages. Messages are not visible to other users until you press the Enter key on your keyboard to send them. Sent messages then appear in the Message Area.

See Also:
The Office Hours Views
The Office Hours Owner Window
The Office Hours Owner Window
Using Help Desks

About Help Desks

Help Desks are a special kind of Office Hours that can be set up by your institution to provide online access to offices and services. You can think of them as permanent Office Hours sessions managed by a particular department or office. Only users that are designated as its staff members can be owners of a particular Help Desk. While any Blackboard IM user can be assigned as Help Desk staff (regardless of whether they are a student or an instructor), the Help Desks themselves can only be created and modified by a Blackboard IM Administrator. If your institution has enabled Help Desks, they are listed under the School tab in the Blackboard IM window. You can join and participate in a Help Desk session in the same way that you would for any other Office Hours.

One key difference between Help Desks and Office Hours is that Help Desks can be staffed (or owned) by more than one user at a time. For example, if a school’s library has three research assistants on duty at a time, all three of them can staff the same Help Desk simultaneously. When a Help Desk has more than one staff member, the session has one, shared list of waiting users, but a separate Main Room for each staff member. Promotion and demotion of participants between the Waiting Room and the Main Rooms is handled just like in Office Hours.

For more information on creating, modifying, and managing Help Desks, refer to the Blackboard IM Administrator’s Guide.
The School Tab

The School tab is visible next to the Contacts and Classmates tabs in the Blackboard IM window if your institution has activated at least one Help Desk. This tab shows all of the published Help Desks and their current status (available, offline, or full). Depending on your institution's setup, Help Desks may or may not be separated into categories. There is no way to move Help Desks between categories, or create new categories like groups in the Contacts tab.

The Help Desk List

The Help Desk List shows you all of the Help Desks that your institution has activated. You can join any open Help Desk from this list. Open Help Desks display the available icon 🤝 next to their names; closed Help Desks display the offline icon ⏳. You can also hover your cursor over the name of a Help Desk in the list to show a more detailed description.
My Staff Positions

If you have been designated as a staff member for a Help Desk by your institution's Blackboard IM Administrator, the Help Desk is listed in the My Staff Positions section of the School tab. You can assume the staff role for any Help Desk from this list. Like with the main Help Desk List, the My Staff Positions section shows the status of all listed Help Desks. Help Desks that are already staffed by another user display the available icon 🔄; Help Desks that are not currently staffed, and are therefore closed, display the offline icon ☹.

See Also:
Joining a Help Desk
Assuming the Staff Role for a Help Desk

Joining a Help Desk

Joining a Help Desk is just like joining Office Hours, except that you can only access Help Desks from the School tab. You can join any Help Desk that is currently open. Open Help Desks display the available icon 🔄; closed Help Desks display the offline icon ☹.

To Join a Help Desk

1. Do one of the following:
   - Double-click the name of the Help Desk you wish to join.
   - Click the name of the Help Desk you wish to join and press the Enter key on your keyboard.

If the Help Desk does not require that you provide a reason for entering, a new Help Desk window opens and you are added to the Waiting Room.
If the Help Desk requires that you provide a reason for entering, a new window opens, prompting you for this information.

2. Type your reason for joining the Help Desk in the text box.
3. Click OK. A new Help Desk window opens and you are added to the Waiting Room.

**Note:**
If the Help Desk has automatic promotion enabled and you are the next person in line, you will be automatically promoted to the Main Room as soon as you enter the Waiting Room. If there are other users ahead of you, or if automatic promotion is disabled, you first enter the Waiting Room.

**Tip:**
If a Help Desk is hosted by more than one staff member, you cannot choose to which staff member's room you are promoted. However, since staff members can see the reason you give for joining a Help Desk, the more detailed you make your description, the more likely it is that you will be promoted by the staff member that can best assist you.

**See Also:**
Assuming the Staff Role for a Help Desk
The School Tab

---

**Assuming the Staff Role for a Help Desk**

Only users that have been designated as staff members for a Help Desk can assume the staff role and serve as a session's host. The Help Desks for which you are a staff member are listed in the My Staff Positions section of the School tab.
To Assume the Staff Role for a Help Desk

1. Double-click the name of the Help Desk that you wish to staff in the My Staff Positions list. The Help Desk Staff window opens.

![Help Desk Staff Window](image)

2. Select how you wish to be identified; you can either be identified by your real name or as an anonymous representative (in which case your name appears as **Representative number**).

3. Click **OK**. You assume the staff role for the Help Desk and a new Help Desk window opens.

---

**Note:**
Unlike with Office Hours, when you are staffing a Help Desk, your status does not change; other users do not know that you are staffing a Help Desk and can still contact you privately.

---

**Tip:**
It is possible to assume the staff role for multiple Help Desks simultaneously.

---

**Tip:**
You can use the **Alerts Preferences** to have Blackboard IM sound an audible alert when a user joins a help desk.

---

**See Also:**
Joining a Help Desk  
The School Tab  
Leaving the Staff Role for a Help Desk

---

Leaving the Staff Role for a Help Desk

To stop staffing a help desk, close the Help Desk window by doing either of the following:
- Press Ctrl+F4 (Windows) or Command-W (Macintosh).
- Click the close button in the upper right-hand corner of the window.

**Creating and Managing Help Desks**

Creating, modifying, and managing Help Desks is performed from the Blackboard IM Administration interface and is only accessible to an institution's Blackboard IM Administrator. For more information, refer to the *Blackboard IM Administrator's Guide*. 
Message Logs

Saving a Single Chat

While it is possible to enable Blackboard IM to automatically save message logs of all of your Chats, you can also save a single Chat as an .html file. This feature can be useful if there is information in a Chat session that you want to be able to refer to later, but you don't want to have to search through all of your message logs to find it. You can save a single chat from any form of text-based chat, including Chat, Office Hours, and Help Desks.

To Save a Single Chat

1. Click the File menu in the window of the chat that you wish to save.
2. Select Save As... The Save Chat Log window opens.
3. Choose the location where you wish to save the log.
4. Type a name for the log in the File name box.
5. Click Save.

See Also:
Viewing Message Logs
Enabling Automatic Message Log Saving
Enabling Automatic Message Log Saving

By default, automatic message log saving is disabled in Blackboard IM. If you wish to automatically store messages logs of all of your Chats, you can enable this feature in the Preferences window.

To Enable Automatic Message Log Saving

1. Click the Blackboard IM menu.
2. Select Preferences. The Preferences window opens.
3. Select General (if it is not already selected).
4. Check the Save chat logs box.
5. Click OK.

Note:
If you upgraded to Blackboard IM from an earlier version, message log saving may already be enabled by default. Uncheck the Save chat logs box to disable it.

See Also:
Viewing Message Logs
Saving a Single Chat

Viewing Message Logs

You can set Blackboard IM to automatically store messages logs of all of your Chats. If enabled, logs are saved to your hard drive as plain text files that contain the text, time, and date sent for each message. Messages logs are never stored on the Blackboard IM server.

To View the Message Log Between You and a Particular User

1. Select the name of the desired user in either the Contacts or the Classmates tab.
2. On the People menu, click Show Chat Log.
   The message log opens.
**See Also:**
- Enabling Automatic Message Log Saving
- Saving a Single Chat
Preferences

Accessing the Preferences Window

The Preferences window gives you access to wide range of options and settings for using Blackboard IM.

To Access the Preferences Window

1. Click the Blackboard IM menu.
2. Select Preferences. The Preferences window opens.
General Preferences

Sign In

- **Start Blackboard IM when my computer starts** automatically launches Blackboard IM every time you turn on your computer.
- **Sign me in when Blackboard IM starts** automatically signs you on to Blackboard IM using the current Blackboard IM account every time you launch the program.
Messages

- **Use tabbed chats** opens new Chats as tabs within one window, rather than separate windows.
- **New message window is always blank** opens new Chat windows without showing previous messages sent between you and the other user.
- **Enter key sends messages (Shift-Enter for line break)** allows you to use the Enter key on your keyboard to send messages in Chat.
- **Warn me before closing a chat with multiple participants** displays a warning dialog when you try to close a chat window with more than one participant.
- **Give keyboard focus to new messages** brings incoming messages to the front or, if tabs are enabled, automatically displays the tab of the new messages.
- **Disable emoticons** disables the display of emoticon images.

Updates

- **Automatically check for Blackboard IM updates** allows you to set whether Blackboard IM automatically checks for new software updates. If selected, the **When Blackboard IM updates are found**: options can be modified.
- **Ask me what I want to do** prompts you before downloading an update.
- **Automatically download the update** downloads updates without notifying you.

Chat Logs

- **Save chat logs** allows you to set whether or not chat logs of all of your Chat conversations are automatically saved on your hard drive.

Language

The Language drop-down menu allows you to set the language for the Blackboard IM interface. By default this is set to match the language setting for your computer's operating system (if possible). For more information, see *Language Settings* on page 142.
Appearance Preferences

The Messages area displays a preview of the current appearance settings for the Chat window; any changes you make in the sections below are reflected in this preview.


**Header**
You can change the text color for your name and the names of other users in the Chat window by clicking the respective color boxes. You can change the font for the names by clicking the Choose Font... button.

**Message Body**
You can change the color of the message text in the Chat window by clicking the color box labeled text. You can change the background color of the Chat window by clicking the color box labeled background. You can change the font for the message text by clicking the Choose Font... button.

**Contact List**
You can change the font that is used to display the names of users, groups, courses, and Help Desks by clicking the Choose Font... button in the Contact List area.

**Reset Appearance Defaults**
If you want to undo all changes you have made and return to the original appearance defaults, click the Reset Appearance Defaults button.

**Status Preferences**
The Status section allows you to add, delete, and modify your custom status messages. Statuses that you have already created are shown in the list.
You can add a new status by clicking the plus button \( + \) or remove a selected status by clicking the minus button \( - \). Select a status and click **Edit** to modify it. The **Auto-Idle** check box allows you to set a time after which your status is automatically set to idle.

**Alerts Preferences**

The Alerts section allows you to set a custom alert profile for a number of different actions in Blackboard IM.
- **When this happens**: lists all of the actions for which you can set alerts.
- Once you select an action from the list, you can set which type of alert you want to associate with it in the **Do this** area.
- The **Use alerts for my contacts only** checkbox is a global setting that allows you to apply the alerts that you have defined only to people in your Contacts tab.
- **Alert sound output**: allows you to choose the sound device used for playing alert sounds.
Calls Preferences

- **Audio Input** allows you to select the device that Blackboard IM uses for incoming audio.
- **Audio Output** allows you to select the device that Blackboard IM uses for outgoing audio.
- **Talk Hot Key** allows you to select the hot key that toggles the Talk button in Chat.

  **Note for Macintosh:**
  By default, if Spaces is enabled then F8 opens Spaces. To use it to toggle the talk button, open the System Preferences, select Keyboard shortcuts and then Expose & Spaces, and turn off the default F8 shortcut for "Activate Spaces".

- **Auto Gain Control** can help normalize the volume of incoming and outgoing audio by automatically boosting low-level audio and lowering high-level audio.
- **Echo Cancellation** eliminates echoes if you are using a speaker and microphone (as opposed to a headset).
- **Microphone Boost** raises the level of your audio input if your microphone level is too weak.
- **Noise Reduction** can help reduce the level of background noise picked up by your microphone.
- **Silence Detection** allows you to transmit audio only when you are speaking, preventing static or background noise.
- **Video Device** allows you to select the device that Blackboard IM uses for video input.
- **Video Connection** allows you to adjust the video quality in Blackboard IM to match your connection speed.
- **Automatically select new devices when inserted** allows you to set whether or not Blackboard IM automatically uses audio and video devices that are connected while the program is running.
Privacy Preferences

- **Block List** displays users that you have blocked from contacting you.
- The **plus** button + allows you to add new users to your Block List.
- The **minus** button - allows you to remove selected users from your Block List.
- **Sign in as invisible** automatically sets your status to invisible when you log in to your Blackboard IM account.
- **Don't show when I am typing** disables the pencil icon 🖊 that informs other users that you are typing.
- **Make me invisible to anyone not in my classes or contacts** always displays your status as invisible to any user not in your Contacts or Classmates tab.

Profile Preferences

![Profile Preferences](image)

- Email: luis@example.com
- About Me: I'm a physics geek.
- My Webpages:
  - URL: http://lcruz@example.com
  - Description: My home page
Profile Picture
You can add a picture that is visible to other Blackboard IM users to add a personal touch to your profile. Your picture is visible any time you contact another Blackboard IM user, anytime another user contacts you, when a user views your profile, or when a user hovers his or her cursor over your name in the Contacts or Classmates tab. To add a profile picture, either drag and drop an image file from your hard drive to the Drag Image Here box, or click the Choose Picture... button and browse your hard drive for the desired picture. The profile picture box is optimized for square images, but accepts images of any proportions.

Email
You can add an email address to make it easier for other users to contact you even if you are not online. This address does not need to be your school email address, or the address associated with your Blackboard IM account.

About Me
The About Me box allows you to enter a brief description to introduce yourself to other users. This could include your interests, your major, where you're from, or the type of people with whom you would like to communicate using Blackboard IM.

My Webpages
The My Webpages box allows you to include links in your profile to the webpages of your choice.
Other Features

Broadcast Notifications

Broadcast Notifications let administrators send institution-wide notifications to all of their Blackboard IM users. Notifications can only be sent by an institution's Blackboard IM Administrator; neither students nor instructors can create or modify notifications. When an institution sends a notification, it is visible to all of its Blackboard IM users for the amount of time specified when it was created. If you are either online when the notification is sent, or you log in to your account during the time in which it is active, the notification appears as a pop-up message. The notification stays visible until you acknowledge it.

Broadcast Notifications display the name of the sender, the message text, the time sent and, optionally, a link for more information.

For further details on creating and sending Broadcast Notifications, refer to the Administrator's Guide.
**Keyboard Shortcuts**

The following keyboard shortcuts can make it easier to access certain features in Blackboard IM:

## Main Window

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut (Windows)</th>
<th>Shortcut (Macintosh)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add contact</td>
<td>Ctrl + Shift + A</td>
<td>Command + Shift + A</td>
</tr>
<tr>
<td>Add group</td>
<td>Ctrl + Shift + G</td>
<td>Command + Shift + G</td>
</tr>
<tr>
<td>Block user</td>
<td>Ctrl + Shift + B</td>
<td>Command + Shift + B</td>
</tr>
<tr>
<td>Call</td>
<td>Ctrl + K</td>
<td>Command + K</td>
</tr>
<tr>
<td>Chat</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Close window</td>
<td>Alt-F4</td>
<td>Command + W</td>
</tr>
<tr>
<td>New group chat</td>
<td>Ctrl + Alt + G</td>
<td>Command + Option + G</td>
</tr>
<tr>
<td>Open help</td>
<td>F1</td>
<td></td>
</tr>
<tr>
<td>Open preferences</td>
<td>Ctrl-,</td>
<td>Command + ,</td>
</tr>
<tr>
<td>Remove user or group</td>
<td>Shift + Del</td>
<td>Command + Del</td>
</tr>
<tr>
<td>Show message log</td>
<td>Ctrl + L</td>
<td>Command + L</td>
</tr>
<tr>
<td>Show profile info</td>
<td>Ctrl + I</td>
<td>Command + I</td>
</tr>
<tr>
<td>Web conference</td>
<td>CTRL + U</td>
<td>Command + U</td>
</tr>
</tbody>
</table>
## Chat Window

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut (Windows)</th>
<th>Shortcut (Macintosh)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block contact</td>
<td>Ctrl + Shift + B</td>
<td>Command + Shift + B</td>
</tr>
<tr>
<td>Call</td>
<td>Ctrl + K</td>
<td>Command + K</td>
</tr>
<tr>
<td>Close</td>
<td>Esc</td>
<td>Command + W</td>
</tr>
<tr>
<td>Cycle through chat tabs</td>
<td>Ctrl + Tab</td>
<td>Command + left arrow, Command + right arrow</td>
</tr>
<tr>
<td>Change chat tabs</td>
<td>Ctrl + 1, Ctrl + 2, Ctrl + 3, etc.</td>
<td>Command + 1, Command + 2, Command + 3, etc.</td>
</tr>
<tr>
<td>Edit &gt; Copy</td>
<td>Ctrl + C</td>
<td>Command + C</td>
</tr>
<tr>
<td>Edit &gt; Cut</td>
<td>Ctrl + X</td>
<td>Command + X</td>
</tr>
<tr>
<td>Edit &gt; Paste</td>
<td>Ctrl + V</td>
<td>Command + V</td>
</tr>
<tr>
<td>Edit &gt; Redo</td>
<td>Ctrl + Y</td>
<td>Command + Y</td>
</tr>
<tr>
<td>Edit &gt; Select All</td>
<td>Ctrl + A</td>
<td>Command + A</td>
</tr>
<tr>
<td>Edit &gt; Undo</td>
<td>Ctrl + Z</td>
<td>Command + Z</td>
</tr>
<tr>
<td>Insert tab into message</td>
<td>Ctrl + Shift + Tab</td>
<td>Option + Tab</td>
</tr>
<tr>
<td>Invite to collaborate</td>
<td>Ctrl + Alt + C</td>
<td>Command + Option + C</td>
</tr>
<tr>
<td>New group chat</td>
<td>Ctrl + Alt + G</td>
<td>Command + Option + G</td>
</tr>
<tr>
<td>Open emoticon picker</td>
<td>Ctrl + E</td>
<td>Command + E</td>
</tr>
<tr>
<td>Open help</td>
<td>F1</td>
<td></td>
</tr>
<tr>
<td>Open preferences</td>
<td>Ctrl + ,</td>
<td>Command + ,</td>
</tr>
<tr>
<td>Save as</td>
<td>Ctrl + S</td>
<td>Command + S</td>
</tr>
<tr>
<td>Show chat log</td>
<td>Ctrl + L</td>
<td>Command + L</td>
</tr>
<tr>
<td>Show profile info</td>
<td>Ctrl + I</td>
<td>Command + I</td>
</tr>
<tr>
<td>Start Screen Sharing</td>
<td>Ctrl + Alt + S</td>
<td>Command + Option + S</td>
</tr>
<tr>
<td>Start Web Tour</td>
<td>Ctrl + Alt + U</td>
<td>Command + Option + U</td>
</tr>
<tr>
<td>Start Whiteboard</td>
<td>Ctrl + Alt + W</td>
<td>Command + Option + W</td>
</tr>
</tbody>
</table>

Other Features
## Audio & Video Window

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut (Windows)</th>
<th>Shortcut (Macintosh)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Ctrl + F4</td>
<td>Command + W</td>
</tr>
<tr>
<td>Show video preview</td>
<td>Ctrl + Shift + D</td>
<td>Command + Shift + D</td>
</tr>
<tr>
<td>Temporarily hold Talk button down</td>
<td>Ctrl, F8, or none</td>
<td>Control, F8, or none</td>
</tr>
<tr>
<td><strong>Note</strong>: This is configurable via the Calls Preferences.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toggle full-screen mode</td>
<td>Ctrl + F</td>
<td>Command + F</td>
</tr>
<tr>
<td>Toggle Talk button</td>
<td>Ctrl + T</td>
<td>Command + T</td>
</tr>
<tr>
<td>Toggle Video button</td>
<td>Ctrl + D</td>
<td>Command + D</td>
</tr>
<tr>
<td>Video Capture</td>
<td>Ctrl + E</td>
<td>Command + E</td>
</tr>
</tbody>
</table>
### Office Hours window and Help Desk window

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut (Windows)</th>
<th>Shortcut (Macintosh)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block contact</td>
<td>Ctrl + Shift + B</td>
<td>Command + Shift + B</td>
</tr>
<tr>
<td>Call</td>
<td>Ctrl + K</td>
<td>Command + K</td>
</tr>
<tr>
<td>Chat</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Close</td>
<td>Esc</td>
<td>Command + W</td>
</tr>
<tr>
<td>Edit &gt; Copy</td>
<td>Ctrl + C</td>
<td>Command + C</td>
</tr>
<tr>
<td>Edit &gt; Cut</td>
<td>Ctrl + X</td>
<td>Command + X</td>
</tr>
<tr>
<td>Edit &gt; Paste</td>
<td>Ctrl + V</td>
<td>Command + V</td>
</tr>
<tr>
<td>Edit &gt; Redo</td>
<td>Ctrl + Y</td>
<td>Command + Y</td>
</tr>
<tr>
<td>Edit &gt; Select All</td>
<td>Ctrl + A</td>
<td>Command + A</td>
</tr>
<tr>
<td>Edit &gt; Undo</td>
<td>Ctrl + Z</td>
<td>Command + Z</td>
</tr>
<tr>
<td>New group chat</td>
<td>Ctrl + Alt + G</td>
<td>Command + Option + G</td>
</tr>
<tr>
<td>Open help</td>
<td>F1</td>
<td></td>
</tr>
<tr>
<td>Open preferences</td>
<td>Ctrl + ,</td>
<td>Command + ,</td>
</tr>
<tr>
<td>Remove user</td>
<td>Ctrl + Shift + R</td>
<td>Command + Shift + R</td>
</tr>
<tr>
<td>Save As</td>
<td>Ctrl + S</td>
<td>Command + S</td>
</tr>
<tr>
<td>Show message log</td>
<td>Ctrl + L</td>
<td>Command + K</td>
</tr>
<tr>
<td>Show profile info</td>
<td>Ctrl + I</td>
<td>Command + I</td>
</tr>
</tbody>
</table>
### Whiteboard

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut (Windows)</th>
<th>Shortcut (Macintosh)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Ctrl + S</td>
<td>Command + S</td>
</tr>
<tr>
<td>Save Page</td>
<td>Ctrl + Shift + S</td>
<td>Command + Option + S</td>
</tr>
<tr>
<td>Import</td>
<td>Ctrl + O</td>
<td>Command + O</td>
</tr>
<tr>
<td>New Page</td>
<td>Ctrl + N</td>
<td>Command + N</td>
</tr>
<tr>
<td>Edit &gt; Undo</td>
<td>Ctrl + Z</td>
<td>Command + Z</td>
</tr>
<tr>
<td>Edit &gt; Cut</td>
<td>Ctrl + X</td>
<td>Command + X</td>
</tr>
<tr>
<td>Edit &gt; Copy</td>
<td>Ctrl + C</td>
<td>Command + C</td>
</tr>
<tr>
<td>Edit &gt; Paste</td>
<td>Ctrl + V</td>
<td>Command + V</td>
</tr>
<tr>
<td>Edit &gt; Select All</td>
<td>Ctrl + A</td>
<td>Command + A</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Ctrl + D</td>
<td>Command + D</td>
</tr>
<tr>
<td>Send to back</td>
<td>Ctrl + [</td>
<td>Command + [</td>
</tr>
<tr>
<td>Bring to front</td>
<td>Ctrl + ]</td>
<td>Command + ]</td>
</tr>
<tr>
<td>Move selected object(s)</td>
<td>arrow keys</td>
<td>arrow keys</td>
</tr>
<tr>
<td>Go to previous page</td>
<td>Page Up</td>
<td>Page Up</td>
</tr>
<tr>
<td>Go to next page</td>
<td>Page Down</td>
<td>Page Down</td>
</tr>
<tr>
<td>Go to first page</td>
<td>Home</td>
<td>Home</td>
</tr>
<tr>
<td>Go to last page</td>
<td>End</td>
<td>End</td>
</tr>
</tbody>
</table>

### Web Tour

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut (Windows)</th>
<th>Shortcut (Macintosh)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go back</td>
<td>ALT + left arrow</td>
<td>Command + [</td>
</tr>
<tr>
<td>Go forward</td>
<td>ALT + right arrow</td>
<td>Command + ]</td>
</tr>
</tbody>
</table>
**General**

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut (Windows)</th>
<th>Shortcut (Macintosh)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide application</td>
<td></td>
<td>Command + H</td>
</tr>
<tr>
<td>Hide others</td>
<td></td>
<td>Command + Option + H</td>
</tr>
<tr>
<td>Minimize window</td>
<td></td>
<td>Command + M</td>
</tr>
<tr>
<td>Quit</td>
<td></td>
<td>Command + Q</td>
</tr>
<tr>
<td>Show contact list</td>
<td></td>
<td>Command + Option + 1</td>
</tr>
<tr>
<td>Open contextual (right-click) menu</td>
<td>Shift + F10</td>
<td></td>
</tr>
</tbody>
</table>

**Notes for Macintosh:**

- In order for the Command + W shortcut to work (to end a call and close the Audio Video window), open the System Preferences, select Keyboard, and select "All Controls" under "Full Keyboard Access".
- By default, if Spaces is enabled then F8 opens Spaces. To use it to toggle the talk button, open the System Preferences, select Keyboard shortcuts and then Expose & Spaces, and turn off the default F8 shortcut for "Activate Spaces".

**Software Updates**

From time to time, Blackboard Collaborate releases new software updates for Blackboard IM. By default, the program automatically checks for updates periodically and, when an update is found, asks you whether or not you want to download it. You can change these settings in the Preferences window. You can also manually check for updates at any time.

**To Change Your Software Update Settings**

1. Click the **Blackboard IM** menu.
2. Select **Preferences**. The Preferences window opens.
3. Select **General** (if it is not already selected).
4. In the Updates area, adjust the settings as desired:
   - **Automatically check for Blackboard IM updates** allows you to enable or disable automatic update detection. If selected, the **When Blackboard IM updates are found**: options can be modified:
     - **Ask me what I want to do** asks you whether or not you want to download updates when they are detected.
     - **Automatically download the update** downloads updates when they are detected without asking you first.

5. Click OK.

**To Manually Check for Software Updates**

1. Click the **Help** menu in the Blackboard IM window.
2. Select **Check For Updates**. A dialog box appears, telling you whether or not new updates are available.

**Language Settings**

Blackboard IM is available in both English, French, and Spanish. The client contains all three languages; there is no need to download additional language packs. You can change your personal language preference at any time. If you do not set a language preference, Blackboard IM uses the language preference from your computer's operating system (if possible). If your computer's operating system is set to a language other than English, French, or Spanish, Blackboard IM defaults to English.

The Blackboard IM Settings page is available in English and Spanish. The default language for the page is set by your institution’s Blackboard IM Administrator and can be modified individually by each user.

**To Change the Language Setting for the Blackboard IM Client**

1. Click the **Blackboard IM** menu.
2. Select **Preferences**. The Preferences window opens.
3. Select **General** (if it is not already selected).
4. Select the desired language from the **Language** drop-down menu.

5. Click **OK**. Your language preference for the Blackboard IM client is set.
Note:
The language setting that you select in the Preferences window is maintained even if you log out and log back in to the Blackboard IM client.

To Change the Language Setting for the Blackboard IM Settings Page

1. Choose Blackboard IM > Manage My Account to access the Blackboard IM Settings webpage.
2. Click the Language drop-down menu.
3. Select the desired language. Your language setting for the Blackboard IM Settings page is set.

Note:
Changing the language setting for the Blackboard IM Settings page does not affect the language display setting for the Blackboard IM client.

See Also:
General Preferences
Accessing the Blackboard IM Settings Page
Modifying Your Account Settings

Additional Resources

Technical Support
For technical support issue please visit our Support Portal at http://support.blackboardcollaborate.com where you can search our knowledge base, submit a ticket, chat with a support representative or call our help desk.”

Additional Documentation
For more information on Blackboard IM’s more advanced features see the following guides:

- Administrator’s Guide - tells administrators how to configure Blackboard IM.
- Blackboard IM Accessibility Guide - provides details of Blackboard IM accessibility features such as support for screen readers.
- Blackboard IM Computer Lab Installation Guide - tells lab administrators how to set up Blackboard IM in computer labs.
• *Blackboard IM Silent Installation Guide* - describes how to install Blackboard IM through the command line.

• *Blackboard IM Universal Integration Guide* - tells administrators how to synchronize data with the Blackboard IM server.

You can find all these guides, plus more resources, on the Blackboard Collaborate On-Demand Learning Center.

**Community**

We encourage Blackboard Collaborate users of all levels to join our Collaborati User's Group (https://www.coursesites.com/s/_Collaborati), a community in which users can share their experiences, ideas, research, and best practices with their peers via forums and user-generated blogs.

**Blackboard Collaborate Product Feedback**

Blackboard Collaborate welcomes your comments and suggestions. If you have an idea for a new feature or enhancement, or would like to send other feedback, please send an email to BBCollaborateFeedback@blackboard.com.

Your feedback will be sent directly to our Product Management Team.
Index

A
account settings 29-30
accounts 3, 6, 30
adding contacts 17
adding groups 19
alerts preferences 127
appearance preferences 125
audio and video window 53
automatic promotion 96

B
Blackboard Enterprise 5
Blackboard IM ID 4-5, 20, 28
Blackboard Learn 5
Blackboard Vista/Campus WebCT 5
block list 28, 131
blocking users 27
broadcast notifications 135

C
call 51
   ending 56
   starting 52, 84
calls preferences 129
chat 39
   emoticons 43
   ending 50
   group 47
   HTML 43
   saving 117
   starting 39
chat tabs 42
chat window 40
classmates tab 11, 14, 17, 25, 27
CMS 3, 5
collaboration window 59
   closing 82
   opening 59
conference call 53
contacts
  adding 17
  blocking 27
  removing 20
contacts tab 11, 13, 17, 19-20, 25, 27
Course Management System (CMS) 3, 5
course settings 32
D
demoting a user in office hours 97
display settings 25
downloading 6
E
echo cancellation 130
emoticons 43
English 142
G
gallery ribbon 71
general preferences 123
group chat 47
  ending 50
  inviting users 50
  starting 47
groups 13, 19
H
help desks 14, 111
  creating and managing 116
  joining 113
  leaving staff role 115
  school tab 112
HTML tags in chat 43
I
installing 6
instant messaging 39
interface 11
invisibility 132
invitations 3, 34-35
K
keyboard shortcuts 136
L
language settings 142
linking accounts 6
logging in 8
M
main room participant window 90, 107
menu bar 11
messages logs 117
  automatic saving 118
  viewing 118
Moodle 5
My Blackboard 5
My WebCT 5
O
office hours 87
  demoting a user 97
  ending 103
  joining 104
  owner's window 93
  participant window 107
  promoting a user 96
  removing a user 99
  sending a message to the waiting room 101
  starting 90-91
Index
Copyright

This document contains confidential proprietary information and is protected by law. This document and the information contained in it are intended for authorized users only and may be used only for the express purpose of legally accessing and using Blackboard Inc. products; any other use, without Blackboard Inc.’s prior written permission, is strictly prohibited.

© 2012 Blackboard Inc. All Rights Reserved.

Trademarks

Blackboard, the Blackboard logo, Blackboard Collaborate, the Blackboard Collaborate logo, Behind the Blackboard, Wimba and Elluminate are trademarks or registered trademarks of Blackboard Inc. or its subsidiaries in the United States and/or other countries. All rights reserved.

All other brand or product names are trademarks or registered trademarks of their respective companies or organizations.